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About the User’s Guide  
The User’s Guide is designed to aid users with the functionality of the Assessment 

Database version 2 (ADBv2). It is not intended to familiarize the user with Microsoft (MS) 
Access, SQL Server, or Oracle. This user guide will help you in getting started with the ADB, as 
well as understanding some of the features that the ADB will offer.  

 



ADBv2 User Guide 

ii 

 
 
 
 
 
 
 
 

[This page intentionally left blank.] 



ADBv2 User Guide 

iii 

Table of Contents 
About the User’s Guide ................................................................................................................... i 

List of Acronyms .......................................................................................................................... vii 

1. Introduction ................................................................................................................................ 1 
What’s New in Version 2.3? ............................................................................................... 1 
What’s New in Version 2.2? ............................................................................................... 2 
System Overview for Microsoft Access ............................................................................. 3 
System Overview for Oracle ............................................................................................... 3 
System Overview for SQL Server ...................................................................................... 4 
Capabilities ......................................................................................................................... 4 

2. Getting Started ............................................................................................................................ 6 
What You Need................................................................................................................... 6 
Installing the ADB .............................................................................................................. 6 

Microsoft Access Version ....................................................................................... 6 
Oracle Version ........................................................................................................ 6 
SQL Version ........................................................................................................... 7 

Starting the ADB................................................................................................................. 7 
Microsoft Access Version ....................................................................................... 7 
Oracle Version ........................................................................................................ 8 
SQL Version ........................................................................................................... 8 

Demo Data .......................................................................................................................... 9 
Check for Updates............................................................................................................. 10 

3. Managing Data with the ADB .................................................................................................. 11 
Assessments ...................................................................................................................... 11 

Assessment Units .................................................................................................. 11 
Sidebar Menu Options .......................................................................................... 12 
Uses ....................................................................................................................... 18 
Causes ................................................................................................................... 23 
Observed Effects ................................................................................................... 24 
Sources .................................................................................................................. 25 

Determining Categories .................................................................................................... 27 
Delisting ................................................................................................................ 28 

Managing 303(d) Information........................................................................................... 29 
Atlas Information .............................................................................................................. 33 
Browsing Data .................................................................................................................. 34 

Full Browse ........................................................................................................... 34 
Browse by Category .............................................................................................. 35 

4.  Modifying Data Elements ........................................................................................................ 37 
Look-Up Groups ............................................................................................................... 37 
Pollutants and Nonpollutants ............................................................................................ 38 
Observed Effects ............................................................................................................... 38 
Assessment Method Codes ............................................................................................... 39 
Locations ........................................................................................................................... 39 
User-Defined Categories ................................................................................................... 40 



ADBv2 User Guide 

iv 

Atlas Topic Items .............................................................................................................. 40 

5. Other Features .......................................................................................................................... 42 
Backing-up and Restoring Data ........................................................................................ 42 
Performing Cycle Tracking............................................................................................... 43 
Providing Help Messages ................................................................................................. 44 
Providing Category Listing Definitions ............................................................................ 44 
Exporting Data .................................................................................................................. 44 
Migrating to New Cycle.................................................................................................... 45 
Serving as a Shell to External Applications ...................................................................... 46 
Resetting the Database ...................................................................................................... 46 
Compacting the Database ................................................................................................. 46 

6.  ADB Modules ........................................................................................................................... 47 
Data Validation Module .................................................................................................... 47 

Check Dates .......................................................................................................... 47 
Finalize Cycle ....................................................................................................... 48 

Connections Module ......................................................................................................... 50 
Establishing a Database Connection ..................................................................... 51 
Establishing a Table Connection .......................................................................... 52 
Viewing Data Within the ADB ............................................................................. 54 

Reports Module ................................................................................................................. 54 
State Reports ......................................................................................................... 54 
Summary Reports.................................................................................................. 55 
AU Detail Reports................................................................................................. 56 

Probability Survey Module ............................................................................................... 57 
Results ............................................................................................................................... 58 

Adding Projects ..................................................................................................... 58 
Viewing and Updating Projects ............................................................................ 59 
Deleting Projects ................................................................................................... 59 
View Summary ..................................................................................................... 60 
View Report .......................................................................................................... 60 

Browse .............................................................................................................................. 60 

7. Submitting the Database ........................................................................................................... 61 

8. Frequently Asked Questions .................................................................................................... 63 

9. User Support and Technical Assistance ................................................................................... 65 

Appendix A – Assessment Database Installation Guide ............................................................. A-1 
Assessment Database Installation Guide for Microsoft Access ..................................... A-3 

System Requirements.......................................................................................... A-3 
Installing the ADBv2 .......................................................................................... A-3 

Assessment Database Installation Guide for Oracle ....................................................... A-4 
System Requirements.......................................................................................... A-4 
Installing the ADBv2 .......................................................................................... A-4 
DBA Tools .......................................................................................................... A-5 
Synonyms ............................................................................................................ A-5 
Privileges............................................................................................................. A-5 



ADBv2 User Guide 

v 

Assessment Database Installation Guide for SQL Server............................................... A-6 
System Requirements.......................................................................................... A-6 
Installing the ADBv2 .......................................................................................... A-6 
DBA Tools .......................................................................................................... A-7 

Appendix B – Troubleshooting ................................................................................................... B-1 
Troubleshooting for the Access Version......................................................................... B-3 
Troubleshooting for the Oracle Version ......................................................................... B-3 
Troubleshooting for the SQL Server Version ................................................................. B-4 

Appendix C – ADB Data Dictionary .......................................................................................... C-1 
 



ADBv2 User Guide 

vi 

 
 
 
 
 
 
 
 

[This page intentionally left blank.] 
 



ADBv2 User Guide 

vii 

List of Acronyms 
 
ADB Assessment Database 
ADBv2 Assessment Database version 2 
AU Assessment Unit 
CAS Chemical Abstracts Service 
CWA Clean Water Act 
DBA database administrator 
EPA U.S. Environmental Protection Agency 
GIS geographic information system(s) 
GUI graphical user interface 
HABs harmful algal blooms 
HUC hydrologic unit code 
IBIs Indices of Biotic Integrity 
MS Microsoft 
NHD National Hydrography Dataset 
ODBC Open Database Connectivity 
RBS rollback 
RTF Rich Text Format 
STORET STOrage and RETrieval system 
TMDL Total Maximum Daily Load 
TNS Trivial Name Server 
WQS Water Quality Standards 
WQSDB Water Quality Standards Database 

 



ADBv2 User Guide 

viii 

 
 
 
 
 
 
 
 

[This page intentionally left blank.] 
 



ADBv2 User Guide 

1 

1. Introduction  
The U.S. Environmental Protection Agency’s (EPA’s) Assessment Database (ADB) 

software was developed as a tool for State environmental agencies to store assessment 
information generated under Section 305(b) of the Clean Water Act (CWA). The EPA supported 
the development and distribution of ADB software to help ease the burden of State reporting, 
encourage standardization of reporting between States and facilitate the generation of the 
National Assessment Database and the biennial National Water Quality Inventory. The ADB 
software is designed to store assessment information in a manner consistent with EPA’s 
Guidance for 2008 Assessment, Listing and Reporting Requirements Pursuant to Sections 303(d) 
and 305(b) of the Clean Water Act (EPA 2006); henceforth referred to as the Guidance, which is 
available at http://www.epa.gov/owow/tmdl/2008_ir_memorandum.html. In the Guidance, EPA 
encourages States to integrate the reporting requirements under Sections 305(b) and 303(d) of 
the CWA (EPA 2003). The ADBv2 is designed to facilitate the integration of the two programs.  

The main function of the ADBv2 is to store assessment information in compliance with 
EPA’s Guidance on generating 305(b) and 303(d) reports. The ADBv2 can also produce the 
attainment category report, as defined by the Guidance, based on that assessment information. 
This report can be exported from the database in tabular format.  

What’s New in Version 2.3? 
 Modified Delisting Forms and Delisting Reason List.  The modified delisting reason 
list now includes a designation between delisitings and WQS attainment.  The updated list is as 
follows: 
 Delistings: 

• Data and/or information lacking to determine water quality status; original 
basis for listing was incorrect (Category 3) 

• TMDL approved or established by EPA (Category 4A) 
• TMDL Alternative (Category 4B) 
• Not caused by a pollutant (Category 4C) 

 WQS Attainment: 
• Applicable WQS attained; original basis for listing was incorrect 
• Applicable WQS attained; due to restoration activities 
• Applicable WQS attained; due to change in WQS 
• Applicable WQS attained; according to new assessment method 
• Applicable WQS attained; threatened water no longer threatened 
• Applicable WQS attained; reason for recovery unspecified 

 
 5M – Mercury Reduction Strategy Information.  Added in description and URL fields 
to track mercury reduction strategy information. 
 
 NPDES ID field added.  Expanded data fields for 4B (TMDL alternative) to include 
NPDES information. 
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 User Defined Category at the Use and Cause levels.  Added a field for states to 
designate a user defined category at the use and cause levels.  In the case of the user defined 
cause category, this will be the place for a state to designate a 5M water. 
 EPA Added Flags.  Added flags at the assessment unit, use attainment, and cause levels 
to track if a cause of impairment was added by EPA. 
 
 Consent Decree.  Added a field to track the cycle of consent decree if an AU-cause 
combination was part of a consent decree. 
 
 Improved Data Exports.  Added TMDL and other fields to data exports. 
 
 Comment Fields.  Added in comment filed at the observed effects and sources levels. 
 
 New Water Types.  Added in new water types: 

• Great Lake Connecting Channel 
• Ditch or Canal 
• Inland Lake Shoreline 

 
 New Assessment Type.  Added in new assessment type: 

• Other 
 

What’s New in Version 2.2? 
Probability Survey Module. The Probability Survey Module is designed to store water 

quality assessment information, which has been gathered using probability-based assessment 
methods. The user can store all of the data elements suggested by the Guidance, as well as 
geographic information system (GIS) coverages, documents, and other assessment-related 
information. The probability survey also allows the user to browse, export, summarize, and 
report the information within the module. 

Category Determination at the Assessment Unit, Use, and Cause Levels. The 
ADBv2.2 has been updated to support multiple category determinations per assessment unit in 
accordance with the Guidance. A single Assessment Unit (AU) can now have one attainment 
category, one attainment category per designated use, or one attainment category per use and 
cause. 

Delisting. The ADBv2.2 allows a user to keep track of causes that were previously listed 
on the State’s 303(d) list for a particular cause of impairment, the dates of delisting, and the 
reason or rationale for delisting. 

Atlas Information. The Atlas Information screen allows a user to independently track 
the total water size in the state according to each source and/or scale cited. 

Trend Analysis. The ADBv2 includes the ability to track the trend status for each AU.  
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New Reports. The ADBv2 now offers an Atlas Information Report, a delisting summary, 
and a Total Maximum Daily Load (TMDL) status update report. Additionally, the AU Summary 
Report has been updated to provide more flexibility in report creation.  

Copy an Assessment Unit. The ADBv2 allows a user to copy an AU within the cycle 
and use it as a template to create a new AU. 

TMDL Information. Additional fields have been added to aid States in tracking TMDL 
status and project information. 

Cycle Last Assessed. A user can now view the last time an assessment unit was assessed 
from the main Assessment Units screen. 

Assessment Date. The Assessment Date field has been moved to the designated use level 
to allow for the possibility that waters may be assessed for different uses on different dates. 

System Overview for Microsoft Access 
The ADBv2 is a relational database application based on an MS Access database with a 

Visual Basic user interface. The ADB includes two files: a user interface file and a database file. 
The user interface file must be installed locally on each user’s machine. This file contains all of 
the graphical screens and tools that allow the user to enter and view data. The second file is a 
database file (MS Access file) that stores all of the data. This file may be stored on an individual 
machine or on a server to allow access by multiple users. One of the advantages of this two-file 
design is that the graphical interface can be improved without affecting the table structure or data 
stored in the database file. 

The user interface of the MS Access version is virtually the same as the Oracle version, 
which was originally used to develop the ADBv2; however, choosing to use the MS Access 
version does not allow the user to take advantage of the power of the Oracle database. MS 
Access ADBv2 users will sacrifice 1) a more secure environment for data storage and the ability 
to create user profiles with specific data privileges, 2) the ability to restore lost or corrupted data 
and significantly lower incidents of database corruption, 3) data back-up features, 4) increased 
data storage capacity (e.g., Oracle version of ADBv2 can store data from multiple reporting 
cycles that could easily exceed the 2 gigabyte storage space capacity in MS Access), and 5) Web 
servability. 

System Overview for Oracle  
The ADBv2 for Oracle is a relational database application based on an Oracle database 

with a Visual Basic user interface. The ADB includes two files:  a user interface file and a 
database file. The user interface file must be installed locally on each user’s machine. This file 
contains all of the graphical screens and tools that allow the user to enter and view data. The 
second file is a database file (Oracle 8.1.x) that stores all of the data. This file may be stored on 
an individual machine or onto a server for access by multiple users. An advantage of this two-file 
design is that the graphical interface can be improved without affecting the table structure or data 
stored in the database file. 
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System Overview for SQL Server 
The ADBv2 for SQL is a relational database application based on a SQL Server database 

with a Visual Basic user interface. The ADB includes two files: a user interface file and a 
database file. The user interface file must be installed locally on each user’s machine. This file 
contains all of the graphical screens and tools that allow the user to enter and view data. The 
second file is a database file that stores all of the data. This file may be stored on an individual 
machine or on a server for access by multiple users. An advantage of this two-file design is that 
the graphical interface can be improved without affecting the table structure or data stored in the 
database file. 

Capabilities 
Some of the things you can do with the ADBv2 include the following: 

# Create category listing reports for the new Guidance 
# Create reports that can be presented in ArcView 
# Store documents associated with AUs 
# Add comments in Rich Text Format (RTF) 
# Connect to different data sources (e.g., Oracle, SQL Server, MS Access, Open Database 

Connectivity [ODBC]) 
# Browse data in table form 
# Migrate data from previous cycles 
# Create Summary Reports. 
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2. Getting Started  

What You Need  
The purpose of the ADB is to store and track assessments using a core unit called an AU. 

An AU is a unique waterbody segment identifier with assigned designated uses based on the 
State’s Water Quality Standards (WQS). These designated uses can be assessed and the 
assessment results stored in the ADB. Before you get started with the ADB, you’ll want to take 
some time to examine your assessment methodologies and data tracking techniques. You may 
want to consider how you want to define your AUs. Because Category 5 waters become the 
303(d) list, make sure to delineate these AUs appropriately and assign them the correct size. The 
Guidance looks to States to provide information about the status and progress made towards 
achieving comprehensive assessment of all waters in the State for the Integrated Report. This 
means that you will need to think about how to categorize the waters that are not currently part of 
your 305(b) program. You will want to think about how to break up these unassessed waters into 
AUs. If you georeference your AUs to National Hydrography Dataset (NHD), there are GIS tools 
available from EPA to help you with this process.  

You will also want to have a copy of your State’s WQS document on hand. ADBv2 uses 
EPA’s Water Quality Standards Database (WQSDB) as the basis for the uses in the ADB. You 
can obtain a copy of your State’s designated uses as they appear in the WQSDB at 
http://www.epa.gov/ost/wqs.  

Installing the ADB 

Microsoft Access Version 

For detailed instructions on installing the ADB, see Appendix A of this document or 
“Installing the ADB,” which is available in the “Reference” section at http://www.epa.gov/ 
waters/adb. There are two parts to the installation of the ADB: installing the user interface, such 
as data entry and viewing forms, and installing the database, or the actual MS Access data tables. 
You do not need MS Access installed to run the ADB.  

Oracle Version 

For detailed instructions on installing the ADB, see Appendix A of this document 
“Installing the ADB,” which is available in the “Reference” section at http://www.epa.gov/ 
waters/adb. There are two parts to the installation of the ADB: installing the user interface, such 
as data entry and viewing forms, and installing the database, or the actual Oracle data tables. You 
may want to have your Oracle database administrator (DBA) handle the database installation for 
you.  

Your can also set up users for the ADB. There are two types of ADB users: 
Administrators and Users. Personnel who have been assigned an administrator role can add, 
delete, and modify data. Personnel who have been assigned a user role can only view data. The 
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ADBv2 comes with a default user called ADBUSER (this is also the password). ADBUSER has 
administrative privileges, so all of your assessment data may be entered using this login. You can 
also have your DBA remove ADBUSER if database security is a concern. 

SQL Version 
For detailed instructions on installing the ADB, see Appendix A of this document or 

“Installing the ADB,” which is available in the “Reference” section at http://www.epa.gov/ 
waters/adb. There are two parts to the installation of the ADB: installing the user interface, such 
as data entry and viewing forms, and installing the database, or the actual SQL Server data 
tables. You may want to have your SQL Server DBA handle the database installation for you.  

Your DBA can also set up users for the ADB. There are two types of ADB users: 
administrators and users. Personnel who have been assigned the administrator role can add, 
delete, and modify data. Personnel who have been assigned a user role can only view data. 
Users’ roles must be set up set up before data can be entered or viewed via the user interface. 

Starting the ADB 

Microsoft Access Version 

After installing the ADB Interface, you will have a new item on your Start->Programs 
menu in Windows called ADBv2 for Access. Select ADBv2 from this menu to start the 
application. You will be prompted to navigate to the ADBaccess.mdb database if you see the 
following message:  

 

The ADBaccess.mdb database will be located where you or your DBA has saved the file. 
The default pathway for the database is C://ADBaccess.mdb. 

The first time you start the ADB, you will be prompted to select the State with which you 
will be working. If no data exists for the current cycle, you will be asked if you want to begin 
working on the current cycle. If you click No, you will then be asked to select an existing cycle. 
The ADB will default to this selected state and cycle the next time you start the ADB. You can 
change the state and cycle you are working with at any time using the Data menu.  
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Oracle Version 

After installing the ADB Interface, you will have a new item on your Start->Programs 
menu in Windows called ADBv2 for Oracle. Select ADBv2 from this menu to start the 
application. You will be prompted to enter the database name, a user name, and password. Use 
the default settings (shown below) or check with your Oracle DBA for the appropriate entries for 
this dialog.  

 

The first time you start the ADB, you will be prompted to select the State with which you 
will be working. If no data exists for the current cycle, you will be asked if you want to begin 
working on the current cycle. If you click No, you will then be asked to select an existing cycle. 
The ADB will default to this selected state and cycle the next time you start the ADB. You can 
change the state and cycle you are working with at any time using the Data menu. 

SQL Version 

After installing the ADB Interface, you will have a new item on your Start->Programs 
menu in Windows called ADBv2 for SQL Server. Select ADBv2 from this menu to start the 
application. In the “Connect to Database” dialog box, you will have to enter the name of the 
server that has the SQL Server database. Next, specify a security option. You have two security 
choices: Windows NT security or user-level security. If you use NT security, you will need to 
enter a user name and password. Before you can use the ADB you will need to be set up as a user 
and assigned an ADB User role. Once you enter this information, the ADB will record your 
entries (except for the password) to speed up your login to the ADB. Use the default settings 
(shown below) or check with your SQL Server DBA to find the appropriate entries for this 
dialog. User-level security does not require you to enter a password. 

 

The first time you start the ADB, you will be prompted to select the State with which you 
will be working. If no data exists for the current cycle, you will be asked if you want to begin 
working on the current cycle. If you click No, you will then be asked to select an existing cycle. 
The ADB will default to this selected state and cycle the next time you start the ADB. You can 
change the state and cycle you are working with at any time using the Data menu. 
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Demo Data  
The ADB is currently loaded with two cycles of demo data. It is not necessary for you to 

delete this data before you start. Adding new AUs, deleting AUs, adding causes or comments, or 
any other changes, may be made to this demo data without affecting your State’s data in any 
way.
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Check for Updates  
The Check for Updates feature is available from the File menu in the main ADBv2 

screen. You can use this feature to check for any new sources, causes, and software updates to 
the database.  

 

When updating your ADB to the most current version, be sure to check all three tabs: 
Software, Tables, and Database. Start with the Database tab on the right, followed by Tables 
and Software.  In the Database tab, click CONNECT and wait for the system to analyze your 
working database version. When the text box below Your Database Version is populated, click 
the UPGRADE CATEGORY VIEWS button, then the UPGRADE button (the button will be 
grayed out until the category view update completes). In the Tables tab, follow Steps 1 through 3 
sequentially; and simply hit the UPDATE button in the Software tab to complete the ADB 
upgrade. 
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3. Managing Data with the ADB  

 

The main screen of the ADB features six directional buttons: 

# Assessments 
# Impaired Waters 303(d) 
# Browse 
# Atlas Information 
# 5M Documentation 
# Exit 

Assessments 
To track the assessments and assessment results for your AUs, ADBv2 requires you to 

enter information about the type and quality of the assessment that was performed. If an AU is 
not meeting one or more of its designated uses, the causes and sources of impairment for each 
use can be recorded. This section will give an overview of how to enter an assessment into the 
database.  

Assessment Units 

To access assessments, click on the Assessments button on the main EPA Assessment 
Database screen. Assessment information associated with an AU may include designated uses, 



ADBv2 User Guide 

12 

assessment metadata, causes of impairment (or observed effects), and sources of impairment. 
This information can be accessed using the sidebar on the left side of the dialog box.  

 

To return directly to the Assessment Units screen from anywhere in the database, click 
on the “Assessment Unit” icon. To exit the “Assessments” portion of the ADB application, go to 
the “Assessment Units” screen and click CLOSE. This will return you to the main ADB menu.  

Sidebar Menu Options  

Throughout the application, there are a series of buttons that line the left side of each 
screen. These buttons will always take you to the selected information; however, the level of 
information detail will depend on the screen from which they are accessed. For example, the 
Causes button always lists contaminants associated with selected AUs. Clicking on the Causes 
button on the Assessment Units screen will show all causes associated with a selected AU. 
However, clicking on the Causes button on the Uses screen will show only the causes associated 
with the selected AU and selected use. A brief description of each button follows:  
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Assessment Units: This button takes the user to the Assessment Unit screen.  
 
 
Uses: This button takes the user to the Uses screen.  
 
Assessment Documentation: This button shows metadata associated with the AU and 
designated use. Metadata can be added, removed, or changed when accessed through the 
sidebar on the Uses screen.  

Observed Effects:  This button directs the user to observed effects associated with the AU and 
designated use. Observed effects can be added, removed, or changed when accessed through 
the sidebar on the Uses screen.  

Causes: This button shows causes associated with the AU and designated use. Causes can be 
added and deleted when accessed through the sidebar on the Uses screen.  
 
Sources: This button shows sources of impairment for the selected AU, designated use, and 
cause. Sources can be added and deleted when accessed through the sidebar on the Causes 
screen.  

Determine Category: This button informs users of the AU’s category as defined in the 
Guidance.  
 

Delisting:  This button shows any delistings associated with the selected AU.  
 

Viewing or Updating Assessment Information 

An AU may be updated by selecting its name or ID from the drop-down boxes so that the 
descriptive information for the selected unit appears in the Assessment Units screen. You may 
also choose to limit by category the list of AUs that appear in the Select an Assessment Unit 
drop-down list if you want to examine the information for waters that fall within a specific 
group. In the Information screen, the user may edit the assessment unit ID, AU name, 
waterbody type and size, location, use class, user defined category, trophic status, trend, whether 
the AU was an EPA added water, and 314 public lake status. Click the Update Current 
Assessment Unit button to replace the former values. The size may be updated by double-
clicking on the current value.  

Adding an Assessment Unit  

The user may add new AUs by clicking Create New Assessment Unit in the “Assessment 
Unit Functions” section on the Assessment Units screen. This opens a new dialog that prompts 
the user to enter the AU ID, name, and location. All of these data elements are required. You 
may also use the “Copy Information from Existing Assessment Unit” to quickly add any 
assessment metadata that is identical to an existing AU. For instance, two AUs sharing the same 
geographic location may share identical uses, causes, or documents.  
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 After the information is entered and the Add button is clicked, another dialog box opens 
that prompts the user for water type and size. Once you select the desired water type, the size 
units you should enter will appear in the dialog. When you are finished, click Add.  

 

Once this information is entered, the new AU is created and will appear in the drop-down 
boxes and frames on the Assessment Units screen. If you wish to add additional water types to 
an AU, click on the Add Type button in the “Information” section of the “Assessment Units” 
dialog box.  

Deleting an Assessment Unit  

An AU may be deleted by selecting the name or ID from the Select an Assessment Unit 
drop-down boxes and clicking the Delete Current Assessment Unit button. This will remove the 
AU and all related assessment information from the database.  
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Splitting an Assessment Unit  

An AU may be split by selecting the name or ID from the Select an Assessment Unit 
drop-down boxes and clicking the Split Current Assessment Unit button. An AU may be split 
into two and any or all of assessment information may be copied to each unit by checking the 
appropriate boxes below Select data to transfer to new assessment unit. Use the tabs located on 
the upper right side of the dialog box to switch between the units. 

 

Associating a Use Class with an Assessment Unit  

Note:  The Use Class drop-down list will only be visible if the state you are working on uses the 
class system.  

For States or jurisdictions that use a class system to group designated uses, the ADBv2 
allows users to add a class to a new AU. After adding a new AU, click the Use Class drop-down 
box to see a list of available classes. The See Definition button will provide a description of the 
selected class. After the appropriate class is selected, click the Update Current Assessment Unit 
button under “Assessment Unit Functions.” When you add designated uses to the AU, the list of 
uses you may choose from will be limited to uses associated with the class you assigned to the 
AU. You can change the class of an AU in the main Assessment Units screen.  
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Assigning a User-Defined Category to an Assessment Unit  

In some cases, States have categories for reporting at a State and local level. ADBv2 
allows users to create “User Defined Categories.” The name and description of these categories 
is left completely to the discretion of the user. While these categories may be applied to group 
AUs for a State’s own reporting purposes, it is important to remember that the AUs will still be 
placed in one of the five categories defined by the Guidance that are based on use support.  

To create your own categories, select User Defined Categories from the Modify drop-
down list in the menu bar. Click Add Category and type the name or ID of the category (10 
character maximum) into the text box and click OK. Select the category from the User Defined 
Category drop-down box and then type the category description (4,000 character maximum) in 
the space below. Click Save Description to save the new category and description to the 
database.  

Assigning a Trophic Status and Trend Information  

From the main assessment unit screen, you can also enter trophic status and trend 
information. Trophic status can only be assigned to assessment units encompassing lakes, 
reservoirs, and/or ponds; whereas trend information may be added to all water types. To assign a 
trophic status or trend to an assessment unit, use the drop-down lists located in the lower right 
corner of the screen. 

Adding Comments  

If you click on the Add Comment button below the sidebar in the “Assessment Units” 
dialog box, the “Comment Editor” dialog box opens. ADBv2 allows you to add comments to 
AUs in RTF. This feature also allows you to format comments for easier reading.  
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Comments may be typed directly into this dialog box or imported from other word 
processing documents. This feature can allow you to more extensively edit the created comment, 
including some minor word processing abilities and spell checking features that are built into the 
Comment Editor feature; however, for more extensive formatting, you will need to use word 
processing software. The following features are built into the Comment Editor feature.  

# Bold  
# Underline 
# Italic 
# Change font size 
# Find (Control+F) 

Comments in the ADB can be a maximum of 4,000 characters long. The RTF alters two 
aspects of your comments 1) RTF comments take up more disk space than they usually would, 
and 2) viewing the comment in the database table may look strange because it contains all of the 
RTF codes formatting.  

Adding Files to Assessment Units  

The ADBv2 allows you to associate graphics or other types of files with an AU. You can 
add a .jpeg showing a photo of the site where the assessment was performed or a lengthy 
document describing the AU. To associate a document with an AU, just click Add File on the 
Assessment Units screen. The Add File to Assessment Unit screen will appear.  

 

Click Preview File to add the file to the database. The file will open to allow you to 
review it before adding it to the database. Close the file and click Insert File. You will be 
prompted to enter a description for the file. Once files are added, you can open them, save them 
to another folder, or delete them by clicking one of the buttons under the “Review File” section.  
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There is no limit to the number of documents you can add to an AU; however, the 
database may not be the most effective place to store a large number of documents. It may be 
more efficient to store documents on a file server rather than in your database. 

Accessing Previous Cycle Assessment Information  

By clicking Previous Cycle Info in the lower left corner of the Assessment Units screen, 
you can view assessment information from previous cycles for the selected AU. The ADB 
automatically associates all AUs from previous cycles with identical IDs, however you can 
associate additional AUs or delete associations from this screen. To view a Summary Report for 
a previous cycle, highlight the AU and click the View button. For more information, please see 
the Cycle Tracking section in Chapter 6. 

Adding Other Location Information 

The ADB allows you to enter Other Location Information, including hydrologic unit code 
(HUC), county, and latitude/longitude. 

To add location types or location descriptions to the list available in the drop-down box, 
go to Modify->Locations in the toolbar at the top of the screen and add the respective locational 
types and descriptions. 

Uses 

The “Uses” icon will load a screen that lists all designated uses for the selected AU. Each 
use will be categorized as “Assessed” or “Unassessed.”  If the designated use is assessed, it will 
also list the AU’s use support (i.e., fully supporting, insufficient information, or not supporting). 
Users may add designated uses to the selected AU and add or view assessment metadata 
associated with each use.  

Note: The “Designated Uses” that are listed are from EPA’s WQSDB, which is populated with 
the data from the States’ WQS documents. If a “Use” is not specified in your WQS document, it 
will not be available in this list. For more information on the WQSDB, visit http://www.epa.gov/ 
wqsdatabase. 
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Adding Uses 

To add a use to an AU, click on the “Uses” icon at the top of the sidebar. The “Select a 
Use” dialog box will open. You can choose a single designated use or select multiple uses by 
holding down the Shift key when selecting.  

 

When you click the ADD button, the selected use(s) will be added to the list of 
unassessed uses on the Uses screen. 

Use Support and Assessment Documentation  

The “Assessment Documentation” dialog box shows the use support rating and all 
assessment documentation currently associated with the selected designated use. Assessment 
documentation in the ADB includes the type of assessments that were made (e.g., biological, 
habitat) and the confidence in the assessment (e.g., good, fair). 
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To add assessment documentation for a designated use, change the Use Support rating 
from Not Assessed to one of the other categories in the drop-down list by double clicking an 
unassessed use or by selecting one (or choose several by holding down the Shift key) and 
clicking on the “Assessment Documentation” icon in the sidebar. When you do this, the 
“Assessment Documentation” dialog box will open. Please note that you cannot save the Use 
Support for a designated use without assigning at least one assessment type and confidence 
rating.  

 

Once you have assigned a use support, click ADD under Assessments Performed to add 
assessment metadata. When asked if you want to save changes to the AU, click Yes. This will 
open the “Add Assessment Metadata” dialog box.  

 

The metadata choices in the database should reflect the decision logic in a State’s 
Assessment Methodology Document. The required metadata elements are Available Assessment 
Types and Confidence of Assessment. Descriptions of the options for both choices are below.  
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Types of Assessments  

Biological: A biological assessment can include any type of biological (bioassessment) 
indicators that were used (e.g., macroinvertebrate indicators, fish Indices of Biotic Integrity 
[IBIs]).  

Habitat: A habitat assessment can include habitat indicators or other types of geofluvial 
analyses related to features, such as riffle and pool analyses, substrate, bank stability, and stream 
buffer zone plant cover analyses.  

Physical/Chemical: This is a broad category that can include any number of different 
types of analyses. Physical monitoring involves measures for system properties, such as pH, 
turbidity, or temperature. Chemical monitoring is typically performed for specific analytes (e.g., 
copper) that can be defined through reference to Chemical Abstracts Service (CAS) registry 
numbers. If this category clearly defined in a State’s Assessment Methodology Document, then it 
could cover the xenobiotic chemical pollutants in tissue residues associated with fish or wildlife 
consumption advisories.  

Toxicological:  This category includes use attainment conclusions based on methods 
such as bioassays. These can include acute or chronic bioassays for ambient water or for 
interstitial pore water. Other types of monitoring information may be relevant depending on how 
toxicity concerns are addressed in a State’s Assessment Methodology Document. For instance, if 
this category is clearly defined in a State’s Assessment Methodology Document, then it could 
cover the xenobiotic chemical pollutants (e.g., mercury/methyl mercury) in tissue residues 
associated with fish or wildlife consumption advisories. This category would also be appropriate 
to document biogenic toxic concerns related to red tides, cyanobacteria toxins, toxins from 
Pfestieria, or other harmful algal blooms (HABs).  

Pathogen Indicators (Microbials): This assessment type can include any standard 
pathogen (microbial) indicators. An example of a pathogen indicator would be E. coli counts. It 
can also include conclusions from screening test determinations for actual bacterial and viral 
pathogens (e.g., tests for Crytosporidium).  

Other Public Health Indicators: Other indicators related to public health (e.g., oil 
spills) that could not be categorized by other assessment types.  

Other Aquatic Life Indicators: Other indicators related to aquatic life that could not be 
categorized by one of the other assessment types.  

Other:  Any other assessment type that cannot be categorized into one of the above 
assessment types. 

When making entries into the ADB, the user should be certain that a given metadata 
category is related to the specific use being assessed. For example, it would not make sense to 
have a Habitat assessment associated with a Primary Contact Recreation use. The State’s 
Assessment Methodology Document should describe what types of assessment metadata 
categories can be associated with each WQS designated use.  
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Confidence of Assessment 

The database no longer requires that a statement be made about the confidence of the 
assessment or the confidence of the data used to make the assessment. The levels of confidence 
defined in the database include the following:  

1.  Low  
2.  Fair  
3. Good  
4.  Excellent  

 

How a State assigns these levels of confidence should be explained in its Assessment 
Methodology Document.  

Assessment Date and Assessed By 
 You may now enter what date the assessment was taken and by whom. 

User Flag  

The User Flag field may be used to track certain data situations in the ADBv2. For 
example, if a user wants to indicate that an assessment partially supports a designated use, they 
can enter the word Partial in the User Flag field for that AU. The User Flag has no effect on the 
AU’s category. 

User Defined Use Category 
 This is similar to the User Defined Category at the AU level, but is specific to the use 
level. 

Assessment Method Codes  

Users can add custom assessment method codes under Other Assessment Information 
by clicking on the drop-down box and selecting a code. Users may also add their own assessment 
codes by clicking on Modify->Assessment Methods from the menu bar. Assessment methods are 
not required as part of the assessment documentation. 

EPA Added Flag 
 This flag will determine if the use was added by EPA. 

Threatened Status 

If an AU is fully supporting its use, but a non attaining use support is anticipated by the 
next cycle, the AU should be designated as threatened. You can change the status of the 
threatened flag by selecting the Yes button under the “Threatened” dialog box on the right side of 
the “Assessment Documentation” window. Please note that changing the threatened status from 
No to Yes will impair the use for the purposes of determining the category. 
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Causes  

In ADBv2, causes are assigned to uses that are assigned to an AU. Causes may only be 
added to uses that have a not supporting, threatened, or insufficient information attainment 
status. To add or view causes, select an assessed use from the “Uses” dialog box and click on the 
Causes button. This will open the “Causes” dialog box.  

 

Double click on the Causes to view their descriptions or remove a cause by selecting it 
and clicking delete. You can enter a date or priority that the AU is scheduled to receive a TMDL 
by selecting a Cause and clicking the TMDL Information button near the right side of the 
screen. You can also associate causes with TMDLs by clicking on the 303(d) Information button 
near the bottom of the screen. When you click this button, you can select an EPA-approved 
TMDL. (See Managing 303(d) Information later in Chapter 3). You should note that information 
entered on the main Cause screen can influence the determined assessment category of a use or 
AU. For example, if you determine that a Cause is not a pollutant, then that will change the cause 
to Category 4C and can change the use and AU to a Category 4C.  

Adding a Cause  

To add a Cause, either click on the ADD button near the middle of the Causes screen or 
click the Add Cause button on the sidebar. This will open the “Add Causes” dialog box. You can 
select the causes you want to assign to a designated use from the list box on the right side of the 
dialog box. There are currently about 500 causes to choose from and this number will grow over 
time. To make it easier to find the causes you need, this program defaults to only show the 
causes you have assigned to other AUs. You can view all of the available causes by clicking the 
Show All button. You can also show select groups of causes (i.e., nutrients, pathogens, 
bioassays) by clicking the Show Only button and selecting one of the groups from the drop-down 
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list. Additionally, the ADBv2 allows you to create custom groupings of causes (see the section 
on Look-Up Groups in Chapter 4).  

 

The “Add Causes” dialog box has a built-in search feature that will allow you to limit the 
list of causes by words or phrases. In the “Search” portion of the dialog box, select the type of 
search you would like to perform. You can search by cause name, CAS number, or cause 
description. Type in the corresponding search text and click on GO. The Causes list will show 
only the causes that contain the word or phrase you searched. Clicking the Refresh button will 
return the list to its previous state before the search.  

To view the information for a cause, select the cause from the Causes list. The 
description for the cause will appear in the “Information” section. If you would like to select 
multiple causes to assign to a designated use, click on the Multi-Select button. This will allow 
you to select multiple causes in the Causes list by holding down the Shift key, but the cause 
description will no longer be updated in the “Information” section. When you are finished adding 
causes, click ADD to update the data and return to the main “Causes” dialog box.  

To return to the Uses screen when you are finished entering causes, click on the Uses 
button on the sidebar.  

Observed Effects  

Observed effects are added to a designated use similarly to the ways causes are added; 
however, observed effects can be added to uses that are “Fully Supporting” and not threatened, 
whereas causes cannot. Observed effects are monitoring observations that indicate a decline in 
water quality, but are not necessarily considered causes of impairments. Some examples of 
observed effects might include Secchi Depth measurements or fish kills. For a discussion on 
observed effects and how to use them, see the ADB Best Practices Document available from the 
Reference section at http://www.epa.gov/waters/adb.  
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To add an observed effect to a designated use, select the use from the “Uses” dialog box 
and click on the Observed Effects button on the sidebar. This opens the “Observed Effects” 
dialog box, which will show you all of the observed effects currently associated with the selected 
use. Click ADD to add observed effects. The “Add Observed Effects” dialog box functions in the 
same manner as the “Add Causes” dialog box described in the previous section.  

Sources  

In ADBv2, sources are associated with the causes for each designated use. To add 
sources, select the Cause from the “Causes” dialog box and click on the Sources button. This 
will open the “Sources” dialog box. By default, sources will be associated with whatever cause 
was last selected. This Cause will show in the title. To associate a source with more causes, 
select additional causes in the Causes Affected box. Clicking on ADD will take you to an “Add 
Sources” dialog box that is very similar to the “Add Causes” dialog box. You will be able to do 
the same types of searches and groupings as you could in the “Causes” dialog box.  

 

The “Sources” dialog box allows you to indicate whether the sources you enter for causes 
are Confirmed (Y) or Unconfirmed (N). The default for sources is N. You may confirm a 
source by double-clicking on it.  
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You may also change source confirmation by clicking on Data->Confirm Sources in the 
menu bar.  

Note: You should be in the Assessment Units screen or the main database screen to confirm 
sources through the Data menu.  

To use the “Confirm Sources” dialog box in the Data drop-down list, select an AU. Now, 
confirm all sources associated with the AU by selecting the Apply to all Uses with Sources radio 
button (the default), and then clicking the Confirm button. If you want to confirm only sources 
associated with specific uses, click the Apply to Specific Uses radio button, select the sources 
that appear in the text box, and click the CONFIRM button. You can also confirm sources 
associated with specific causes of a specific use by clicking the Apply to specific Causes button, 
selecting a cause from the drop-down box, and then clicking CONFIRM.  
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Determining Categories  
The Guidance calls for all water quality attainment statuses to be fully described for each 

AU on the basis of a five-part categorization of use support. As with previous guidances, 
assessment category is fundamentally decided at the designated-use level. The ADBv2 will 
automatically assign AUs to the appropriate category based on information you enter about the 
use support rating of the AU. You can view the category definition assigned to an AU at any 
time by clicking on the Determine Category button in the sidebar or read a detailed description 
of each category in the Guidance by selecting Show Category Definitions from the View menu.  

 

Categories can be determined at the AU level, the uses level, and/or the causes level by 
switching from Single Category Reporting (assessment-level category determinations) to 
Multiple Category Reporting (use- and cause-level category determinations). Table 1 illustrates 
the difference between single- and multi-category reporting. 

Uses Attainment 
Single 

Category 

Multiple 
Category 

(Uses) Causes TMDL? 

Multiple 
Category 
(Causes) 

Aquatic Life Not 
Supporting 

5 
5 

Chlorine Yes 4A 
Mercury No 5 

Recreation 
 

Insufficient 
Information 3  
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Changing from Single to Multiple Category Reporting for a Single 
Assessment Unit   

To change the category reporting options for a single AU, click the Category Reporting 
button in the lower left corner of the “Assessment Units” page. The “Assessment Unit” 
Category Reporting screen will appear. Any modifications performed on this screen are 
specific to the AU and are not applied to all AUs in the database. Use the check boxes under the 
Multiple Category button to determine the category by the use and/or cause level. Click Update 
and then click OK to return to the “Assessment Units” information page. 
 

Changing from Single to Multiple Category Reporting for All Assessment 
Units   

To change the category reporting options for all AUs within the selected reporting cycle, 
select the Category Reporting option from the Data drop-down list in the menu toolbar. The 
Category Reporting screen will appear. You may modify the category reporting options for a 
single AU or all AUs in the reporting cycle. Use the check boxes under the Multiple Category 
button to determine the category by the use and/or cause level. Click UPDATE to save any changes 
to the database and then click CLOSE to return to the previous screen. 

Delisting  

Delisting was introduced in ADBv2.2.0.  It allows users to track delistings within the 
cycle. To view previous delisting information users can select the Delist button on the main AU 
navigation bar. This form, which is D1, shows the delisting tracking entries. If the user performs 
an operation in the ADB, which could be a delisting action, then the user will be prompted by the 
system. Because there is no way for the system to be certain that any of the actions are definite 
delistings, there are no automatic additions to the delisting list.   
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There are several ways of generating delisting information in the ADB.  A modified 
delisting reason list includes a designation between WQS attainment and delisting.  The updated 
available delisting and WQS attainment reasons are as follows: 

Delisting: 

# Data and/or information lacking to determine water quality status; original basis for listing 
was incorrect (Category 3) 

# Adding a TMDL (4A) 
# Adding in expected-to-attain date (4B) 
# Adding a nonpollutant cause of impairment (4C) 

  
 WQS Attainment:  

# Applicable WQS attained; original basis for listing was incorrect 
# Applicable WQS attained; due to restoration activities 
# Applicable WQS attained; due to change in WQS 
# Applicable WQS attained; according to new assessment method 
# Applicable WQS attained; threatened water no longer threatened 
# Applicable WQS attained; reason for recovery unspecified 

For manual delistings, the ADB application does not allow the user to choose reasons 
associated with categories 4A, 4B, or 4C without entering the corresponding underlying data. For 
instance, to delist a cause for a TMDL approval, the user will first need to enter the related 
TMDL information before the AU/Cause combination can be delisted.  Please note, if you are 
delisting multiple causes, you must individually assign a delisting reason to each cause, 
otherwise the other causes will be deleted with no delisting reasons associated with them. 

Managing 303(d) Information  
The 303(d) Impaired waters button on the main database screen functions similarly to the 

Browse feature (see the section on Browsing Data in Chapter 3). The user can view AUs by 
selecting one of the buttons, such as Choose by Cause. Once an AU is selected, users can view 
assessment information by clicking on the tabs on the screen.  
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Users can access the Cause Information: 303(d) screen by clicking the Manage Causes 
button.  

Note: The Cause Information: 303(d) screen is also accessible through the main Causes screen 
in the database.  
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Here, users can move an AU between Categories 5, 4B, and 4A by clicking and dragging 
the cause to another bin. Before AUs can be moved out of Category 5, causes have to be linked 
to AUs that are “Not Supporting” or “Threatened.”  If an AU needs to have causes linked to a 
use, the use will appear in the text box at the top of the screen. Causes can be added with the Add 
Causes button. After a cause is added, the cause will appear in a category. You can assign 303(d) 
List IDs with View Information button under Category 5. The AU can be moved from Category 
5 to other categories. To move an AU from Category 5 or 4A into Category 4B, the user will 
have to enter an Expected to Attain date. You may also enter implementation actions with the 
Implementation Action button below the Category 4B box. To move an AU from Category 5 or 
Category 4B to Category 4A, a TMDL must be assigned.  



ADBv2 User Guide 

32 

 

Implementation Actions  

Implementation actions help define plans for waters expected to attain their standards. 
There is no set list of EPA-approved implementation actions, so a State should enter what seems 
practical. An implementation action can be up to 4,000 characters and can be typed directly into 
the database or imported as a text file that you have created with a word processing program. All 
implementation actions require a date by which that action will take place. An AU can have as 
many implementation actions as desired; however, they can only be assigned to AUs that are 
expected to meet their standards.  
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Like the Comments feature, you can type implementation actions directly into the 
database or import a text file that you have previously created. Click the Add Action button and 
use the calendar feature to assign an Implementation Action Date, then type or insert text from 
a file. Click the Save Action button to associate the Implementation Action with the AU.  

Atlas Information 
The Atlas Information feature allows the user to do the following:  

# Add information for water types that may not be supported for individual AUs (e.g., canals)  
# Store the number of waterbodies as indicated by various geographic scales  
# Report the total sizes of waterbodies according to several sources.   
 

The data stored within the Atlas Information fields are independent of data related to 
individual AUs and therefore does not affect the assessment calculations or reports produced by 
the ADB. You can view create, update, and delete records from the Atlas Information screen. 
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To update an existing record, highlight the record, then edit the size, count, scale, or 
source using the text boxes in the lower left corner. Click the Update bottonto save the 
information. To add or delete an Atlas Item, click the Add New or Delete buttons located to the 
lower of the Atlas Information list box. 

New topic names may be added to the drop-down list by modifying the Atlas 
Information elements. To add new topic names, go to the Modify Menu located in the toolbar at 
the top of the screen. Choose Atlas Topic Items from this menu. From here, you may add as 
many water types to each atlas topics as needed. Click Cancel to return to the Add New Atlas 
Information screen. 

Browsing Data  
When Browse is selected from the main menu screen, you can view and search 

assessment information. Users without administrative privileges will have access to the Browse 
feature. There are two browse options: Full Browse and Browse by Category.  

Full Browse  

The Full Browse option allows you to view descriptive information, use support 
designations, causes, observed effects, assessment metadata, and sources of impairment for all 
AUs. The records can be sorted by clicking on a column heading, which will populate the 
Search in Active Column for drop-down box with all of the values in that selected column. The 
Order by:  drop-down box allows the user to sort by ascending or descending values. The user 
may change assessment information by selecting an AU and clicking the Change button. 
Assuming the user has appropriate database permissions, this will route him or her to whatever 
area he or she wishes to update. For example, if a user is on the Uses tab and clicks on the 
Change button, he or she will be routed to the Uses screen; if a user is on the Sources tab, he or 
she will be routed to the Sources screen, and so on. The Refresh button updates the form to 
show the most recent data in the database. This is helpful if you suspect that data has been 
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changed, but the changes are not showing on the screen. The Filter On button will allow you to 
filter by AU. If you click on Filter On, all of the tabs will show only the AU you have selected. 
You can export the data in Browse by clicking the Export button. This will create a comma 
delimited file (.csv) in a file that you specify.  

 

Browse by Category  

The Browse by Category option allows you to view assessment information by use 
support category (e.g., all Category 1 waters). When a selection is made from the Select a 
category drop-down box, all AUs falling into that category will be listed on the screen. A 
summary of water types and sizes will also appear on the screen. The CHANGE button routes 
the user to the Assessment Units screen where information can be added or deleted. Clicking on 
a column heading will sort the table and populate the Search in Active Column drop-down box. 
If the user selects one AU, he or she may view assessment level information by clicking on the 
tabs at the bottom of the screen.  
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4.  Modifying Data Elements 
The primary mechanism for adding data elements such as look-up groups, new user-

defined categories, and assessment methods is through the Modify menu in the toolbar.  Some 
modifications should be done prior to data entry.  For example, the pollutant status and observed 
effects status modifications will not affect data that is already entered into the ADB.  

 

Look-Up Groups 
Look-Up Groups allow the user to create groupings of causes or sources to simplify data 

entry. If you create a group of causes that are common in your State, you can select that group in 
the “Causes” dialog box, and choose from that short list rather than view the more than 500 
causes in the database.  

The ADBv2 already contains some groupings of causes and sources for your 
convenience. For example, nitrogen is part of the “Nutrients” group. The purpose of these groups 
is to facilitate data entry, as well as provide a framework for creating Summary Reports.  

To add a new group, type the name of the group in the New Group Name field. Then 
click on the Create Group button. You can then select the new group from the drop-down list of 
group names. Add items to your new group by clicking the down arrow. Remove items from the 
group by clicking the up arrow.  
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Pollutants and Nonpollutants  
Every cause can be categorized as either a “Pollutant” or a “Nonpollutant.”  Whether a 

use is impaired by a pollutant can affect which category an AU falls in. By default, all causes 
will be flagged as pollutants. You can change a cause’s category by clicking on the Modify 
menu, and selecting Pollutants/Nonpollutants. If a cause is defaulted as a nonpollutant, then 
every time that cause is added to a use, the pollutant flag will be set to false. Changing the 
default pollutant status of a cause will not affect any causes that have already been added to uses, 
although the user can change the pollutant flag at any time.  

Observed Effects  
Any cause can be assigned as an observed effect, but you may assign some causes to be 

used strictly as observed effects. To assign an observed effect, click on the Modify menu, and 
then click on Observed Effects. This will open a screen where observed effects can be assigned. 
This screen functions in the same manner as cause and source group screens. Please note that if 
the cause you wish to designate as an observed effect has been associated with any AU within 
the reporting cycle, it cannot be designated as an observed effect; however, it can still be 
assigned as an observed effect on an individual AU basis. 
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Assessment Method Codes  
Users may manage their own Assessment Method Codes by clicking on 

Modify->Assessment Methods from the menu bar. You may add or delete any state-specific 
methods from the Manage Assessment Methods screen.  

 

Locations 
To add location types or location descriptions to the list in the “Additional Locations” 

dialog box, go to Modify->Locations in the toolbar at the top of the screen and add the 
respective locational types and descriptions. From this screen, you may add, rename, or delete 
location elements. 
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User-Defined Categories 
To create your own categories, select User Defined Categories from the Modify drop-

down list in the menu bar. Click Add Category and type the name or ID of the category (10 
character maximum) into the text box and click OK. Select the category from the User Defined 
Category drop-down box and then type the category description (4,000 category maximum) in 
the space below. Click Save Description to save the new category and description to the 
database.  

Atlas Topic Items 
To create your own Atlas Topic Items, select Atlas Topic Items from the Modify drop-

down list in the menu bar. From the Select a Topic drop-down list, select the Atlas Topic to 
which you would like to add an item, then type the topic item name into the text box at the 
bottom of the dialog box. Click Add and click OK.  
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5. Other Features 
ADBv2 has several additional features. These features include:  

# Backup/Restore  
# Performing cycle tracking 
# Providing help messages 
# Providing a “category listing” of definitions 
# Exporting data 
# Migrating to new cycle 
# Serving as a shell to external applications 
# Resetting the database 
# Compacting the database 

Backing-up and Restoring Data  
You can create a backup of the data in the database by using the Back-up feature. To do 

this, open the ADB by going to the Start->Programs->ADBv2 for [database type] menu and 
choose ADBv2. From the Data menu, click on Back-up/Restore. The “Data Back-up/Restore 
Data” dialog box will appear.  
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Under the “Back-up” column, click the Back-up All button to create a backup of all data 
in the ADB, including the sample data, by creating an Openme.txt file in 
C:\ADBdata\backup\XXAll_*.  

 

You can create a backup of a subset of data in the database (for a specific cycle and state) 
by clicking the Select Cycle and State button. Specify the state and cycle that you want to create 
a backup for, and then click Back-up. This will create an Openme.txt file in 
C:\ADBdata\backup\[state abbreviation].  

There are two options for restoring data. The first option, Delete and Replace, deletes any 
data that was not originally included in the demo data and restores other data to its original state. 
Any additional AUs and the new data associated with them will be deleted. The second option, 
Replace, only restores the original data. All AUs added to the demo data will be untouched. To 
restore data, choose the type of restore you want to perform under “Restore Options,” then 
specify the “Back-up State” and “Back-up Cycle.”  Next, click on the Choose Back-up button 
and navigate to the Openme.txt file in C:\ADBdata\backup\XXAll*.  

Performing Cycle Tracking 
Cycle tracking was introduced in ADBv2.1.4. It allows users to track an AU across 

multiple cycles. To view previous cycle information, users can select the Previous Cycle Info 
button on the main Assessment Unit page. This screen, Related Assessment Units, shows the 
cycle tracking entries that were automatically or manually generated.  

In the ADB there are two ways of generating tracking information  

1. Automatically – The user can rename or split an AU in the main Assessment Units 
screen, using the Update or Split command buttons. If a previous cycle exists within the 



ADBv2 User Guide 

44 

database, the ADB will track AU name changes. When splitting an AU, 1 of the splits 
may have the same AU ID as the original, but that is not required.  

2. Manually – The user can manually add tracking information from the Related 
Assessment Units screen. From the main Assessment Units screen, select the Previous 
Cycle Info button. Select the AU in the list to add in previous information and select the 
Add Previous button. Select or type in an AU from a previous cycle, enter the previous 
cycle, and enter a reason (split, rename, or join). Manual entry does not require any 
previous cycle to be in the database. 

In automatic tracking, it is important to note that in the case of renaming an AU, only the 
current AU is renamed (i.e., if the AU exists in future cycles, it is not being renamed or updated). 
However, a cycle tracking entry is created to allow the user to track the AU from the current to 
the future cycles. In the cause of splitting an AU if the AU exists in future cycles, it is also being 
split in future cycles. 

Providing Help Messages  
Help messages are available through View->Show Help Messages. The help messages 

change as you move to different areas of the database using the sidebar buttons on the left.  

Providing Category Listing Definitions  
The ADBv2 contains all of the definitions for the listing categories as they appear in the 

Guidance. If at any point in the application you want to know how a category is defined, click on 
View->Show Category Definitions in the main menu.  

Exporting Data  
From the EPA Assessment Data or Assessment Units screens you can export data in 

.csv format that can be opened in MS Excel. The data export file can be used in ArcView to 
display categories of AUs in a map. To do this, a State must have GIS coverage of AUs that have 
the same unique identifiers that are in the ADB. To export data for the selected cycle, choose 
Data Exports from the Data menu.  

# 303(d) List – The available exports include the following AUs on the 303(d) list.  

# Category 4A List – AUs that are impaired or threatened for one or more designated uses that 
already have a TMDL completed.  

# Category 4B List – AUs that are impaired or threatened for one or more designated uses, but 
do not require the development of a TMDL because they are expected to attain the water 
quality standard in the near future.  

# Category 4C List – AUs that are impaired or threatened for one or more designated uses by 
a non-pollutant and do not require the development of a TMDL.  
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# Category List – All AUs and what category listing they fall into from the ADBv2. 

Migrating to New Cycle  
With ADBv2, you can avoid having to re-enter data.  The Cycle Migration tool allows 

you to migrate data from a previous cycle. You can migrate data pertaining to AUs, use 
attainment, or causes. From the menu bar, choose Data->Migrate to New Cycle. Select the 
appropriate cycles in the TO and FROM drop-down boxes, then select the data types that you 
want to migrate in the check boxes below. Click the Start Migration button to begin migrating 
data.  
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Serving as a Shell to External Applications  
Some ADB users have developed companion applications that perform analyses or 

generate reports that are not necessary to satisfy the Integrated Report requirements, but are 
needed to support local, State, or jurisdiction programs and reporting requirements. In ADBv2, 
there is an option to link to external applications and pass the selected AU ID to this application.  

To set the external application, choose View->External Application->Set External 
Application from the menu bar. Enter the application name and navigate to the application in the 
Application Path box. You can also navigate to a Button Icon Path.  

 

If you do not choose a Button Icon Path, the default icon will be used. The button icon 
will appear beside the module icons below the menu bar. To launch the external application, 
simply click the new button.  

 

Resetting the Database  
At any time while using the ADBv2, you may reset the database by going to the File 

menu and choosing Reset Database. Doing this will return you to the ADBv2 main menu screen 
and reset all of the IDs, so that when you work with the database again, it will function as if you 
had just opened it. If you do not want to reset the database, but would rather just return to the 
main database screen, you can click on the blue arrow button below the menu bar.  

Compacting the Database  
If the database needs to be compacted, you will be prompted when you open the 

MS Access version of the ADB. You can also compact the database at any time by choosing 
Compact Database from the File menu. 
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6.  ADB Modules 
The ADBv2 comes with four additional application modules: Data Validation, 

Connections, Reports, and Probability Survey. You can access these modules by using the 
buttons under the ADB main menu bar or by selecting them from the Start->Programs->ADB 
v.2 menu. You will be prompted with a login for these applications, as you are for the ADB. You 
can use the same database name, user name, and password. The icons for these modules are 
shown below.  

 Data Validation Module  
The Data Validation Module serves two purposes: (1) to ensure that all dates were 

entered properly, and (2) to run any final data validation checks to ensure that all of the 
appropriate data have been entered.  

 

Check Dates  

It is understood that often times the person entering the assessment data in the ADB may 
not be the same person determining the crucial dates (i.e., date scheduled to receive a TMDL) for 
the AUs. The Check Dates feature allows you to view and export a list of all of items requiring a 
date or scheduling priority to a comma delimited text file (*.csv), which can be opened using 
MS Excel. This file can then be sent to the person responsible for these crucial dates. That person 
can fill in the dates, save the file as a .csv file, and return the file to the person responsible for the 
ADB. The Data Validation Module will allow you to import this file and will update all of the 
crucial dates for you. You can also enter the dates directly into this form with the “Assigned 
Date” box.  
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Finalize Cycle  

When you finish a reporting cycle, the Finalize Cycle feature can help you make sure that 
your data has all of the necessary components. The Finalize Cycle feature will create log files of 
all the errors that it found during the check. To use the feature, check the appropriate box for the 
validation check you want to perform on the “Finalize Cycle” dialog box and click the Begin 
Validation Checks button. You will be prompted for a storage location for the log files. The log 
files will be saved in .csv format, which can be opened with several different software programs, 
including MS Excel. These log files can also be viewed by opening them in the “Finalize Cycle” 
dialog box. The log files will give you a listing of all of the AUs that may have problems to be 
fixed. You can also view errors in the “Finalize Cycle” dialog box by clicking the Open Log 
button beside the appropriate validation check box.  
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You may use the log files created by this process to limit the list of AUs accessible in the 
Assessment Units screen of the main ADBv2. This is helpful if the validation check encounters 
problems. The log file can limit the AUs to only those that need additional information or 
corrections. To limit the list of AUs by a text file, open the ADB, click the Assessments button 
and choose Limit by Text File from “Limit List By:” dialog box in the “Select an Assessment 
Unit” section of the Assessment Units screen. In the “Limit by List” dialog box, click on the 
Choose New File button to navigate to the file you want so you can limit your AUs. In the drop-
down list, choose the field in the .csv file that corresponds to Assessment Unit ID, then click 
Finish and then Close.  
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 Connections Module 
The ADBv2 comes with a companion application called Connections. This application 

allows the user to access data from other databases (i.e., Oracle, MS Access, SQL Server, or any 
ODBC-compliant database). The Connections Module can be used to link tables of information 
in other databases so they can be viewed within the ADB. Any data accessed through the 
Connections Module will not be included in the electronic submission to EPA. This feature is 
solely for the convenience of the ADB users.  

 

There are four toolbar menus to help you in setting up Connections. The File menu 
allows you to manage database connections or quit the application. The Save database 
information option under the File menu allows you to save database connections so they appear 
under Existing Connections during subsequent uses of the application. The user may click on 
Quit under the File menu or press Control+Q to exit the application. The Connections menu 
allows you to manage table connections. The Windows menu lists the names of all open screens 
and designates the active screen with a check mark.  The Help menu provides version 
information and a phone number and email address for user support help.  
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Establishing a Database Connection  

Two types of database connections must be established to access data: (1) a connection to 
the database file itself, and (2) a connection to the actual table or query you want to access. You 
can establish a database connection by clicking on Connect to a database under the File menu.  

 

You can choose to use a database connection established in a previous session or you can 
create a new connection. To use an existing connection, select the Use Existing Database 
Connection button and click NEXT. This opens a dialog listing of all saved database 
connections. You can delete old database connections or select one to open. If the database you 
are connecting to is password-protected, you will be prompted to enter a password. Otherwise, 
the names of the tables from the database will appear on the Tables tab, and the names of the 
queries will appear in the Views tab.  
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To establish a new database connection, select the Create New Database Connection 
button from the Connect to a database screen. You will be prompted to select the database type 
(i.e., Oracle, SQL Server, MS Access, or ODBC Data Source).  

After selecting a database format, you will be prompted to enter the database location, 
specify security options, and decide whether the connection will be saved after the session ends. 
You may click on the “...” button to navigate to the database file rather than typing in the path. 
Security options allow the user to limit access by a user name and password. The Test 
Connection button allows you to test whether the connection will be successfully established. If 
the connection is successful, you will receive the message “Test Successful.” Checking the Save 
connection on finish box will enable you to access this connection in a later database session. 
You should click on the Finish button to establish the connection. The database tables will 
appear on the Tables tab, and the queries will appear in the Views tab.  

 

Establishing a Table Connection  

You can create table connections to allow you view data while you are working in the 
ADB. For example, if you have an MS Access database that contains data associated with your 
AUs, but are not stored in the ADB, you can create a connection to that MS Access database and 
view and update that MS Access data while working in the ADB.  

You can manage table connections via the Connections menu. The View Existing 
Connection option opens a screen of all saved table connections. You can delete table 
connections from this screen or select one to open. When the connection is opened, you will see 
a table of data; the same table that may be viewed within the ADB.  
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You can create a new table connection by choosing a table or query name and selecting 
Make New Table Connection from the Connections menu. You will be prompted to name the 
new connection. You can limit the information included in the table connection by AU ID, cycle, 
or TMDL ID.  

Once the table connection is made, you may open it by double clicking on the table name 
in the Tables tab. When the table is open, there are a variety of functions you can use to modify 
it by making a field active and right clicking on the field name. You may do the following:  

# Sort Ascending/Descending  
# Copy/Paste  
# Filter  
# Find  
# Export Data  

It may be useful to connect to the ADB tables. Doing this will allow you to create custom 
queries to answer questions, such as, “Which AUs that have the Fish and Aquatic designated use 
are on the Category 5 list for causes from Iron?”  To answer this question, you can connect to the 
ADB by selecting Create New Database Connection from the CONNECT TO A DATABASE 
screen. Select Oracle, SQL Server, or Access as the database type depending on your database 
version. Fill out the appropriate entries to connect to your database (for SQL or Oracle users, you 
may need to check with your DBA to find out what these are). Click on the Views tab and select 
Category 5 Causes. From the Connections menu, choose Advanced SQL. This brings up a 
screen that will allow you to write a query (in much the same way that a query would be written 
in MS Access).  

 

You may include fields in your query output by checking the boxes next to the field 
names. The selected field names will appear in a box at the bottom of the screen. Several drop-
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down boxes on the right side of the screen can help you compose a query. One drop-down box 
contains a list of all the field names. Choose the State field from this box. The middle drop-down 
box allows you to select the filter type (i.e., =, >, <, >=, <=, or < >). The right drop-down box 
allows you to type in or select the filter criteria. Choose a State from this box. You can also click 
GET VALUES to get a full list of available values for the selected field. Once all of the 
selections criteria have been entered, click ADD. You can add additional criteria using “and” or 
“or” statements. Go back to the drop-down box for selecting fields and to choose Cause_Name. 
Type Iron into the text box on the right, or use the GET VALUES button from a list. Once all of 
the queries have been entered, you can either click TEST to see a preview of the table, or click 
the Finish button to execute your query and exit the dialog box. When you click the Finish 
button to complete the query, you will be prompted to name the query. If you click CANCEL, 
the query information will be lost.  

Viewing Data Within the ADB  

Once a table connection has been established in the Connections Module, you may access 
the data through the ADB. All saved table connections can be accessed through the Show 
Connections option under the View menu. This option allows you to view the data and copy and 
paste it into the ADB.  

 

 Reports Module  
The Reports Module allows users to create “canned” reports. You can access the Reports 

module by going to Start->Programs->ADBv2->Reports or by clicking on the button below the 
menu bar in the ADB application.  

There are four types of reports that can be generated in the module: (1) State Reports, (2) 
Summary Reports, and (3) AU Detail Reports and (4) Cycle Comparison Reports. Reports will 
appear in a separate window. If you wish to save a report, go to File->Save As in the toolbar of 
the report window and save it as a text or .html file where appropriate.  

State Reports 

State Reports were a new feature in the ADBv2.2. The following are the six reports that 
are available under this dialog: 

• Assessment Unit Summary List – This report has general information associated 
with the assessment unit including, AU Name, Water Type, Water Size, Location 
Description, Use and associated Attainments, Causes, Sources, and TMDL Status. If 
you have additional locational information (HUC, county, etc.) for each assessment 
unit you can select to have the report organized by one of these instead of just 
alphabetical order.  

# 303(d) List Report – This report shows all waters on the 303(d) list with their associated 
causes, TMDL status, uses, and sources. 
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# 303(d) Delisting Report – This report contains the assessment unit – cause combinations 
that have been removed from the 303(d) list since the last reporting cycle and were 
designated by the ADB user as a delisting. 

 
# WQS Attainments Report – This report contains the assessment unit – cause combinations 

that have been assigned WQS attainment reason for the recovery of the waterbody.  Some of 
these may also be delistings and will appear in the delistings report as well. 
 

# TMDL Status Report – This report lists all of the impaired AUs that require a TMDL and 
any information the user has entered regarding the progress towards submitting a TMDL. 
Each assessment unit-cause combination without a TMDL or expected to attain date where 
the cause is a pollutant must have either a TMDL priority or TMDL schedule date.   
 

# Atlas Report – This report contains a summary of the waterbody information entered under 
Atlas Information and is independent of AU information in the database. 

Summary Reports  

Several different report types can be generated in Summary Reports. These reports 
summarize data in the database and create a table in .html format. Summary Reports allow the 
user to: 

# Generate reports by State-specific water type or general EPA water type 
# Generate summaries based on uses, causes, or sources  
# Create data dumps 
# Produce trophic status reports on all lakes 
# Produce summaries in waterbody quality trends.  
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AU Detail Reports 

The AU Detail Reports allow you to choose specific AUs based on various criteria and 
create custom reports on the selected AU(s). 

 

To limit or add assessment information to be included in the report, select the options 
button in the lower right corner of the screen. The report Options screen has several data 
elements you can choose to include or exclude in an AU Detail Report by checking or 
unchecking the appropriate boxes.  

Cycle Comparison Reports 

Cycle Comparison Reports is a new feature in the ADBv2.3.  This reporting feature 
allows you to select a range of information in which you can compare data from the current cycle 
to the previous cycle.  There are 5 available reports to choose from: 

# Summary Statistics – This report allows you to view the total number of assessment units in 
the current cycle compared to the previous cycle.  You can also compare the current cycle 
Assessment Unit – Cause Combinations and compare Water Sizes by Category for both the 
current and previous cycle. 
 

# Assessment Unit – Cause Combinations Added to List – This report provides a detailed 
list of those assessment unit-cause combinations added to the 303(d) list since the last 
reporting cycle. 

 
# Changed Use Attainments – This report provides a detailed list of those assessment unit-use 

combinations where the use attainment has changed since the last reporting cycle. 
 
# Changed Category (Assessment Unit) – This report provides a detailed list of those 

assessment units that have changed overall category since the last reporting cycle.  You can 
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view the current assessment unit ID and overall category in comparison to the previous cycle 
assessment unit ID and overall category. This report is the most time consuming to run. 

 
# Waters Unaccounted For – This report provides a detailed list of those assessment unit-

cause combinations that were on the 303(d) list in the last reporting cycle but are 
unaccounted for because a delisting/WQS attainment reason has not been provided. 

 
 

 Probability Survey Module 
The Probability Survey Module is a new addition to the ADB and allows you to track 

probability-based survey information in the ADB. Within the Probability Survey Module, you 
can browse, add a new project, import GIS coverages, create a project report, and enter your 
State’s probability-based assessments. 

 

 

The main Probability Survey Module screen is structured similarly to the main ADB 
screen, and the features within the “Results” and “Browse” dialog function are similar to the 
Assessments and Browse screens in the main ADB.  
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Results 
The “Results” dialog box is the principal location to add probability monitoring data, 

update existing data, and create probability survey project reports. In the probability survey, a 
project is the unique unit with which all probability data is associated.  

 

Adding Projects 

To add a probability-based project, click the ADD PROJECT button in the lower left 
corner of the dialog box. A new dialog box will open so you can add required project details.  
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Click ADD to save this project in the database. The “Project Details” window will 
appear. From here, you can add the project details and documents as desired. Click UPDATE to 
save the information, and click CLOSE when you are ready to return to the Results screen.  

Viewing and Updating Projects 

To view or update the details associated with an individual project, select the record in 
the list box you wish to view and click the View Data button in the lower middle portion of the 
dialog box. The Project Details screen will open.  

 

Use the tabs at the top of the dialog box to migrate between the project, geographic, 
attainment, uses, causes, sources, and document information. If you would like to make changes 
to the assessment information, click UPDATE to save any modifications you have made. Adding 
information, such as uses, causes, and files, can be executed using the techniques applied in the 
main ADB interface.  

Deleting Projects 

To delete a project, select the record from the list box you wish to delete and click the 
Delete Project button in the lower middle portion of the dialog box. Click the Yes button to 
confirm the deletion. 



ADBv2 User Guide 

60 

View Summary 

The Probability Survey Module can create pie charts summarizing the attainment 
information associated with each project. To create a summary chart, select the record from the 
list box you wish to summarize and click the View Summary button in the lower middle portion 
of the dialog box.  

 

You can save this chart as a .jpg image by clicking SAVE CHART. Navigate to the 
location you wish to save the chart and click Save in the “Choose Location” window. 

View Report 

The Probability Survey Module can also create report summarizing the attainment 
information associated with each project. To create a report, select the record from the list box 
you wish to summarize and click the View Report button in the lower right portion of the dialog. 
The report will open in a separate window. If you wish to save a report, go to File->Save As in 
the toolbar of the report window and save the file as a text or .html where appropriate.  

Browse 
The “Browse” dialog box is nearly identical in form and function to the Browse feature in 

the main ADB. For more information, please see Browsing Data in Chapter 3. 
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7. Submitting the Database  
After the data for a reporting cycle is correctly entered into the database, it should be 

submitted to your EPA Regional Coordinator. Your database submission should consist of a .zip 
file that includes the .XML files created by backing up your data. When submitting your data, 
also be sure to include any GIS materials that you have developed for the purpose of recording 
location information.  
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8. Frequently Asked Questions  
Q:  If I begin using the MS Access or SQL Server version of the ADBv2 and later decide to use 

the Oracle version, will this be an easy transition?  

A:  Yes. All you would need to do is back-up your data in the MS Access version, then use the 
Replace feature (Data->Back-up/Restore) to import your data once you have the Oracle 
version installed.  

Q:  Can I import previous ADB versions? 

A: Yes if it is an ADBv2 database.  Use the Backup/Restore feature to import your data.  Run 
Check for Updates feature to update your data to the most recent ADBv2 version.  You 
cannot import any ADBv1 databases. 

Q:  Where do I enter the listing category for an Assessment Unit? 

A:  You do not have to enter the listing category. The ADBv2 will automatically assign a 
category to the AU based on the information you enter in the database.  

Q:  Can I change the look-up tables? 

A:  No, the look-up tables cannot be changed. This is to ensure reporting consistency throughout 
the nation.  

Q:  Can I add my own codes?  

A:  The ADBv2 contains nearly 500 cause codes (many come directly out of EPA’s STOrage 
and RETrieval system [STORET]) and nearly 200 source codes. There will always be a need 
for new codes to be added; however, in the interest of national consistency, it is important 
that all new codes be entered through one contact.  Before attempting to get a new code 
added, you should use the Check for Updates feature (available from the File menu in the 
ADBv2 main screen). This will check to see whether new causes or sources have been added. 
If you still need to add a code, contact attainshd-hq@epa.gov.  

Q:  Will the ADBv2 work with MS Vista? 

A: The current version of the ADBv2 is not supported in the MS Vista operating system 
environment. 
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9. User Support and Technical Assistance  
If you require user support or technical assistance for ADBv2, you can e-mail  

attainshd-hq@epa.gov.  
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Assessment Database Installation Guide for Microsoft Access 

System Requirements  

Client (Interface):  
# MS Windows 95, 98, NT, 2000, XP 
# 200 MHz processor 
# 64 MB RAM 
# 20 MB disk space 

Server (Database):  
# 500 MHz processor 
# 128 MB RAM 
# 280 MB disk space 

Installing the ADBv2  

Before Getting Started:  

Before you install the ADB, make sure you do the following:  

1. Confirm that you have administrative privileges on your computer 

2. Remove previous installations of ADBv2, including both the interface and the database 
(Note: This installation will not interfere with ADBv1x).  

Interface:  

To install the ADB Interface, which contains all of the forms and graphical user interface 
(GUI) to interact with the database, double click on Setup.exe. You will be prompted to choose a 
location to install the ADB Interface. By default, it will install in C:\Program Files\ADB v. 2.  

Database:  

To install the ADB, which contains all of the data tables and data structure, unzip the file 
ADBaccess.mdb on either your local hard drive or a network location. Where you store the 
database will affect its performance. ADBaccess.mdb is in a .zip file in the “Databases” folder 
on the CD.  
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Assessment Database Installation Guide for Oracle 

System Requirements 

Client (Interface): 
# MS Windows 95, 98, NT, 2000 
# 200 MHz processor 
# 64 MB RAM 
# 20 MB disk space 
# Oracle 8.1.x Client 

Server (Database): 
# Oracle 8.1.x Server 
# 500 MHz processor 
# 128 MB RAM 
# 280 MB disk space 

Installing the ADBv2 

Before Getting Started: 

Before you install the ADB, make sure you do the following: 

1. Confirm that you have administrative privileges on your computer 

2. Remove any previous installations of ADBv2, including both the interface and the 
database (Note: This installation will not interfere with ADBv1x) 

3. Make sure you do not have another Oracle database named ADB before installing the 
database 

4. Confirm that you are running Oracle 8.1.x on either the client or the server 

5. Delete or rename the folder “C:\ADBdata” if it already exists on your PC. 

Interface: 

To install the ADB interface, which contains all of the forms and GUI to interact with the 
database, double click on ADBSetup.exe. To install only the interface, click on the option that 
says Install Application Only. This will install the ADB interface on your computer. You will be 
prompted to choose a location to install the ADB interface. By default, it will install in 
C:\Program Files\ADB v. 2. 
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Database: 

To install the ADB, which contains all of the data tables, and Oracle data structure, 
double click on ADBSetup.exe. To install both the interface and the database, click on the Install 
Application and ADB Database option. To install only the database, click on the Install ADB 
Database only option. The installation program will create the database in the folder 
“C:\ADBdata.” This installation may take up to 20 minutes. The installation will create one user, 
ADBUSER, with a password of ADBUSER. This user has all of the basic privileges to add, 
delete, update, and view data. However, this user does not have the privileges to delete or modify 
any of the existing tables or view structures. The installation creates a log called log.txt that will 
show if any problems were encountered during the installation. 

DBA Tools 

Tablespaces: 

The ADB requires the following tablespaces: 

# SYSTEM: 75 MB 
# Rollback (RBS): 50 MB 
# USERS: 10 MB 
# TEMP: 20 MB 
# TOOLS: 8 MB 
# ADB_INDX: 10 MB 
# ADB_DATA: 100 MB 

Users: 

The ADB comes with a default user: ADBUSER. To add new users, use the following 
script: 

CREATE USER &USERNAME IDENTIFIED BY &PASSWORD DEFAULT 
TABLESPACE USERS TEMPORARY TABLESPACE TEMP QUOTA UNLIMITED 
ON USERS QUOTA UNLIMITED ON TEMP; 

Synonyms 

For a new user to be able to access the data, he or she will need to have synonyms 
created. To create synonyms for a new user, run the SYN.sql script. 

Privileges 

There are two roles built into the ADB: the ADB_ADMIN_ROLE and the 
ADB_USER_ROLE. The ADB_ADMIN_ROLE has all the privileges necessary to add, delete, 
and modify data. The ADB_USER_ROLE can only view data. Users should be granted roles 
based on what level of access to the database you want them to have. To grant roles, use the 
following script: 

GRANT ADB_ADMIN_ROLE TO &USERNAME; or GRANT ADB_USER_ROLE 
TO &USERNAME; 



ADBv2 User Guide 

A-6 

Assessment Database Installation Guide for SQL Server 

System Requirements 

Client (Interface): 
# MS Windows 95, 98, NT, 2000, XP 
# 200 MHz processor 
# 64 MB RAM 
# 20 MB disk space 

Server (Database): 
# SQL Server 7.0 or higher 
# 500 MHz processor 
# 128 MB RAM 
# 280 MB disk space 

Installing the ADBv2 

Before Getting Started: 

Before you install the ADB, make sure you do the following: 

1. Confirm that you have administrative privileges on your computer 

2. Remove any previous installations of ADBv2, including both the interface and the 
database (Note: This installation will not interfere with ADBv1x) 

3. Confirm that you have access to a SQL Server 7.x or higher data server. 

Interface: 

To install the ADB interface, which contains all of the forms and GUI to interact with the 
database, double click on Setup.exe. 

Database: 

To install the ADB, which contains all of the data tables and SQL Server data structure, 
create a new database on your SQL Server data server called ADB. On the ADB CD in the folder 
“Database” is a SQL Server 7.x backup of the ADB. Use the Restore option under SQL Server 
Enterprise Manager to import all of the ADB Tables and Views. 
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DBA Tools 

Users: 

The ADB does not pre-install any users; instead, you can set up whatever users you want 
to have access to the database. The ADB can support both levels of SQL Server security (both 
Windows NT security and user-specific security). The types of logins that can be accepted are 
managed by the server and not by the ADB. 

Privileges: 

There are two roles built into the ADB: the ADB_ADMIN_USER and the 
ADB_GUEST_USER. The ADB_ADMIN_USER has all the privileges necessary to add, delete, 
and modify data. The ADB_GUEST_USER can only view data. Users should be granted roles 
based on what level of access to the database you want them to have. To grant roles, use 
Enterprise Manager to grant the desired role to a new user. Please note that a user will not be 
able to access any of the ADB data tables until he or she has been granted one of these roles. 
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Troubleshooting for the Access Version 
Problem  Cause  Fix  
Error: Provider not 
available  

This error can occur when you try 
to connect to the ADB via the 
interface. This error is caused by a 
corrupt .dll file on your computer.  

Run Internet Explorer Service Pack 2. This 
will replace all of these critical data 
connection .dlls. This service pack is available 
at http://windowsupdate.microsoft.com/. 

RunTime Error: “Out of  
Memory”  

One of the .dll’s required by the 
application did not install 
correctly.  

Run the file Setupdcp.exe found in the folder 
“ActiveX” on the CD. You should not need to 
reinstall the ADB. 

Cannot delete causes.  
Other unexplainable errors  
when working with Cause 
or Source tables  

This error occurs in machines that 
have Windows 95, 98, and NT. A 
service pack for the Jet 4 (the 
database engine behind MS 
Access) must be updated.  

Run Jet40SP6_9xNT.exe in the folder  
“Jet40update.” Then restart your computer.  

 

Troubleshooting for the Oracle Version 
Problem  Cause  Fix  
Error: No listener  The Oracle listener has not been 

started. 
Start the listener by running LSNRCTL.EXE. 
This file is located in the Oracle home/bin. 
Type “Start” to start the listener. 

Error: Provider not 
available 

This error can occur when you try to 
connect to the ADB via the Interface. 
This error is caused by a corrupt .dll 
file (msdaora.dll) on your computer.  

Run the Internet Explorer Service Pack 2. This 
will replace all of these critical data connection 
.dlls. This service pack is available at 
http://windowsupdate.microsoft.com/. 

Error: No connect 
privileges 

This error can occur if the user you 
are trying to log on as does not have 
“connect” privileges. 

Make sure that the proper role has been 
assigned to the user, either 
ADB_ADMIN_ROLE or ADB_USER_ROLE. 

When I try to install the 
database, I just get a DOS 
prompt with a lot of 
scrolling data. 

This is not an error, but rather is part 
of the install. The Setup must run 
through a number of default oracle 
scripts in order to create the database. 

What you should expect when you see the DOS 
prompt is that it should stall for a minute as it 
creates the tablespaces (this is normal). If you 
are ever prompted for a password or a 
username, then the install was NOT successful. 
Check the log.txt file in C:\ADBdata\Build to 
see a description of what happened. 

Log.txt: Not connected This error can occur during the 
installation of the database. The 
cause of this error is that the setup 
scripts are unable to connect to the 
Oracle database. There are two 
possible causes for this error. Either 
the database did not setup properly or 
the database requires a TNSNAMES 
entry in order to connect to the 
database. 

Check to see if the folder “C:\ADBdata\Build” 
was created along with the folders 
“C:\ADBdata\admin” and “:\ADBdata\oradata.” 
See if the “admin” folder and “oradata” folder 
contain an “ADB” folder. Create a 
TNSNAMES entry for the ADB. 

(continued) 
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Troubleshooting for the Oracle Version (continued) 
Problem  Cause  Fix  
Run makedbNt.bat 
Error: Service not started 

This error can occur if the ADB 
Oracle database is not mounted. 

Go to Start–>Programs–>ADB v.2, then click 
on Start Database. 

Error: Invalid 
UserName/Password 

This error can occur if either the user 
does not exist or if the password 
supplied for that user is incorrect. 

Make sure the user exists. If the user exists, 
then make sure the password is correct. 

Error: Trivial Name 
Server (TNS) could not 
resolve service name 

This error can occur if your database 
name does not match anything in 
your TNSNAMES.ora file. 

Make sure you have pointed to the database 
using the TNSNAMES file. You can modify 
TNSNAMES by using the Oracle program 
“Net8 Configuration Assistant.” 

Error on Install: 
Oraclient8.dll was not 
found 

This error occurs if the Oracle 8 
client is not installed on your 
computer. 

Install the Oracle 8 client. 

Error: No table or 
synonym invalid 

This error occurs if the synonyms 
were not properly created for the 
tables and views. 

Run syn.sql to create the synonyms for a user. 

Error: Data type not 
supported by this client. 

This error occurs if you try to use the 
file or document features of the ADB 
and you are using an Oracle 7 client. 

The document and file features of the ADB will 
not work with the Oracle 7 client; however, the 
rest of the database will function fine. You can 
either install the Oracle 8 client or continue to 
use the Oracle 7 client and not use the 
document or file features. 

Troubleshooting for the SQL Server Version 
Problem  Cause  Fix  
Error: The connected 
database does not appear 
to be an ADB 

This error can occur if the user you 
are trying to log on as does not 
have “connect” privileges. 

Make sure that the proper role has been assigned 
to the user, either ADB_ADMIN_USER or 
ADB_GUEST_USER. 

Error: Login failed This error can occur if either the 
user does not exist or if the 
password supplied for that user is 
incorrect. 

Make sure the user exists. If the user exists, then 
make sure the password is correct. 

Error: Provider not 
available 

This error can occur when you try 
to connect to the ADB via the 
interface. This error is caused by a 
corrupt .dll file on your computer. 

Run the Internet Explorer Service Pack 2. This 
will replace all of these critical data connection 
.dlls. This service pack is available at 
http://windowsupdate.microsoft.com/. 

RunTime Error: “Out of 
Memory” 

One of the .dll’s required by the 
application did not install correctly. 

Run the file Setupdcp.exe found in the folder 
“ActiveX” on the CD. You should not need to 
reinstall the ADB. 

 

This document is intended to assist a user in installing ADBv2. It is not expected that a 
user be fully familiar with all of the aspects of an MS Access, SQL, or Oracle database in order 
to install and run the software. For further technical assistance, please call EPA’s toll-free hotline 
at 1-800-844-0638. 
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ADB 2.3.0 Data Dictionary 
November 2007 

 
ASSESSMENT_METHODS 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – WQS_ATTAINMENTS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – WQS_ATTAINMENTS 
USE_ID EPA unique identifier assigned to a designated 

use 
NUMBER(6) Y PK, FK FK – WQS_ATTAINMENTS 

METHODCODE EPA unique identifier assigned to a method NUMBER(6) Y PK, FK FK – METHOD_LUT 
STATE State or other jurisdiction CHAR(2) Y FK FK – METHOD_LUT 
 
ASSESSMENT_TYPES 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – WQS_ATTAINMENTS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – WQS_ATTAINMENTS 
USE_ID EPA unique identifier assigned to a designated 

use 
NUMBER(6) Y PK, FK FK – WQS_ATTAINMENTS 

ASSMNT_TYPE Code designating a category of data types used to 
make attainment/impairment decision 

NUMBER(6) Y PK, FK FK- 
ASSESSMENT_TYPE_LUT 

ASSMNT_CONF A score ranging from a lower range of 1 to an 
upper range of up to 4 indicating the reliability 
and precision of the applied assessment for a 
category of use-specific assessment type 

CHAR(2) N PK Values in (1, 2, 3, 4) 

 
ASSESSMENT_UNIT_BLOBS 
Field Name Description Type Not Null Constraint Comment 
AU_BLOB_ID Unique identifier for the file NUMBER(7) Y PK  
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y FK FK – ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y FK FK – ASSESSMENT_UNITS 
AU_BLOB_DESC Description for the AU Blob VARCHAR2(255) Y   
AU_BLOB Stored file associated with assessment unit/cycle BLOB N   
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ASSESSMENT_UNITS  
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment 

unit (water segment) ID state 
defined 

VARCHAR2(50) Y PK  

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – STATE_ASSESSMENTS 
STATE ST - the 2 letter postal state 

abbreviations (e.g., VA for 
Virginia); exceptions are for 2 
Interstate commissions. OV stands 
for ORSANCO (the Ohio River 
Valley Water Sanitation 
Commission) and DR stands for 
the Delaware River Basin 
Commission 

CHAR(4) Y PK, FK FK – STATE_ASSESSMENTS 

WATER_NAME Assessment unit name VARCHAR2(100) Y   
LOCATION Description of the assessment 

unit's location 
 

VARCHAR2(255) 
 

Y   

TROPHIC_STATUS Trophic status of publicly owned 
lakes 

VARCHAR2(80) N  Values in (‘U’, ‘D’, ‘H’, ‘E’, 
‘M’, ‘O’) 

PUBLIC_LAKE Flag used to track public lakes CHAR(1) N  Values in (‘Y’, ‘N’) 
MONITORING_SCHEDULE_DATE Calendar year by which additional 

monitoring for attainment status 
will be completed 

CHAR(4) N   

CLASS_ID Unique identifier for class assigned 
from WQSDB 

NUMBER(6) N FK FK – CLASS_LUT 

CATEGORY_ID State defined identifier for a 
category 

VARCHAR2(10) N   

AU_COMMENTS Additional free-text information 
concerning the assessment unit 

VARCHAR2(40) N   

AU_OWNER Used to track owner of the 
assessment unit 

VARCHAR2(10) N   

CYCLE_LAST_ASSESSED Last cycle in which this assessment 
unit was assessed 

CHAR(4) N   

TREND Trend as defined in Section 314 of 
the Clean Water Act 

CHAR(1) N FK FK – TREND_LUT 

CAT_REPORT_FLAG Flag used to track whether an 
assessment unit will be reported in 

CHAR(1) N  Values in (‘S’, ‘U’, ‘C’, ‘B’) 
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single category (S) or multiple 
categories, uses (U) or causes (C) 
or both (B) 

EPA_ADDED Flag indicates whether EPA added 
a water or cause of impairment to 
the 303(d) list 

CHAR(1) N   

 
ASSESSMENT_WATERS  
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – ASSESSMENT_UNITS 
WATER_TYPE Water type of the assessment unit (e.g., River, 

Estuary, Wetland) 
VARCHAR2(30) Y PK, FK FK – WATER_TYPE_LUT 

WATER_SIZE Size of the assessment unit NUMBER(38,6) Y   
 
ATLAS  
Field Name Description Type Not Null Constraint Comment 
STATE State or other jurisdiction CHAR(2) Y PK, FK FK – STATE_ASSESSMENT 
CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – STATE_ASSESSMENT 
TOPIC_ID Code for the water type (i.e., River) or population 

being reported on 
NUMBER(6) Y PK, FK FK – ATLAS_LUT 

TOPIC_OWNER Denotes whether the topic is one of the default 
options or one added by the state 

CHAR(2) Y FK FK – ATLAS_LUT 

TOPIC_SIZE Water or population size for a given topic NUMBER(28,6) N   
TOPIC_SCALE Scale at which the total size is determined (i.e., 

1:100,000) 
VARCHAR2(30) N   

TOPIC_SOURCE Source for the size information VARCHAR2(40) N   
TOPIC_COUNT Count (number) of the specified water type in the 

state 
NUMBER(6) N   
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AU_CAUSES  
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit 

(water segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – ASSESSMENT_UNITS 
CAUSE_ID EPA unique identifier assigned to the 

cause 
NUMBER(6) N PK  

CYCLE_FIRST_LISTED Cycle in which as assessment unit 
was first listed 

CHAR(4) N   

EXPECTED_TO_ATTAIN_DATE Calendar year for which the 
associated uses impaired by this 
impairment will meet their standards 
by other means 

CHAR(4) N   

TMDL_SCHEDULE Calendar year when the jurisdiction 
anticipates submitting the TMDL to 
EPA for approval 

CHAR(4) N   

TMDL_PRIORITY Represents a States TMDL priority. 
Allowed values are H, M, L for High, 
Medium, and Low. 

CHAR(1) N  Values in (‘L’, ‘M’, ‘H’) 

TMDL_COMPLETION_DATE Date the TMDL was completed or the 
date by which a TMDL is expected to 
be completed 

DATE N   

TMDL_PROJECT_STATUS Brief description regarding the status 
of the TMDL development for a 
given assessment unit/cause 
combination. 

VARCHAR2(255) N   

TMDL_PROJECT_COMMENT Additional free-text information 
concerning the TMDL 

VARCHAR2(4000) 
 

N   

CONSENT_DECREE_CYCLE Field indicates whether this 
assessment unit-cause combination 
was included in a consent decree and 
for what cycle. 

CHAR(4) N   

POLLUTANT_SOURCE_TYPE Indicates whether the pollutant source 
type is a point source, non-point 
source, or both (PS/NPS/BOTH) 

CHAR(1) N  Values in ('P','N','B') 

JUSTIFICATION_URL Field stores the URL to a website or 
document justifying a 4B designation 

VARCHAR2(250) N   

OTHER_POINT_SOURCE_ID Field stores information on other 
point sources associated with a 4B 

VARCHAR2(4000) N   
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designation 
 
AU_DELIST 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – ASSESSMENT_UNITS 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK,FK FK – CAUSE_LUT 
DELISTING_REASON Reason given for delisting NUMBER(6) Y FK FK – 

DELISTING_REASON_LUT 
DELISTING_DATE Date on which the delisting occurred DATE N   
DELISTING_COMMENT Additional comment regarding delisting VARCHAR2(4000) N   
 
AU_LOCATIONS 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – ASSESSMENT_UNITS 
LOCID Unique identifier assigned to a location NUMBER(6) Y PK, FK FK – LOCATIONS_LUT 
STATE State or other jurisdiction CHAR(2) Y FK FK – LOCATIONS_LUT 
LATDD Latitude in decimal degrees (only used if loctype 

is lat/long) 
NUMBER(18,6) N   

LONDD Longitude in decimal degrees (only used if 
loctype is lat/long) 

NUMBER(18,6) N   

 
AU_NPDES 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – ASSESSMENT_UNITS 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK,FK FK – CAUSE_LUT 
NPDES_ID NPDES ID number VARCHAR2(9) Y   
 
CAUSE_GROUPS 
Field Name Description Type Not Null Constraint Comment 
CAUSE_GROUP_ID Code designating a grouping of causes NUMBER(6) Y PK, FK FK – CAUSE_GROUP_LUT 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK, FK FK – CAUSE_LUT 
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CAUSES 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – 

WQS_ATTAINMENTS 
CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – 

WQS_ATTAINMENTS 
USE_ID EPA unique identifier assigned to a 

designated use 
NUMBER(6) Y PK, FK FK – 

WQS_ATTAINMENTS 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK, FK FK – CAUSE_LUT 
POLLUTANT_FLAG Flag used to track if cause is a pollutant 

(‘Y’) or non-pollutant (NULL) 
CHAR(1) N  Values in (‘Y’, NULL) 

CONFIDENCE Represents a States confidence in the 
impairment. Allowed values are ‘H’, ‘M’, 
‘L’ for High, Medium, and Low 

CHAR(1) N  Values in (‘L’, ‘M’, ‘H’) 

CAUSE_COMMENTS Additional free-text information concerning 
the impairments 

VARCHAR2(4000) N   

USER_FLAG State definable field for causes VARCHAR2(15) N   
STATE_CAUSE_CATEGORY The integrated report category for the 

assessment unit-cause combination reported 
by the state 

VARCHAR2(10) N   

EPA_ADDED Flag indicates whether EPA added a water 
or cause of impairment to the 303(d) list 

CHAR(1) N   

 
CLASS_USE 
Field Name Description Type Not Null Constraint Comment 
CLASS_ID Unique identifier for CLASS_ID assigned from 

WQSDB 
NUMBER(6) Y PK, FK FK – CLASS_LUT 

USE_ID EPA unique identifier assigned to a designated 
use 

NUMBER(6) Y PK, FK FK – USE_LUT 
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CYCLE_TRACK 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK  

CYCLE Calendar year of the assessment CHAR(4) Y PK  
PREID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK  

PRECYCLE Calendar year of the assessment CHAR(4) Y PK  
PURPOSE Reason for change in assessment unit – Allowed 

values are split, join or rename 
CHAR(10) Y  Values in (‘Split’, ‘Rename’, 

‘Join’) 
AUTO_FLAG Flag used to track if entry is automatic (1) or 

manual (0) 
NUMBER(1) Y  Values in (0, 1) 

 
DBVERSION 
Field Name Description Type Not Null Constraint Comment 
VERSION Version of the back-end database VARCHAR2(10) Y   
 
IMPLEMENTATION_ACTIONS 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit 

(water segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – AU_CAUSES 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – AU_CAUSES 
CAUSE_ID EPA unique identifier assigned to the 

cause 
NUMBER(6) Y PK, FK FK – AU_CAUSES 

ACTION_DATE Date other pollution control requirement 
was/will be completed. 

DATE Y PK  

IMPLEMENTATION_ACTION Pollution control requirements other 
than a TMDL taken for an assessment 
unit to meet standards. 

VARCHAR2(4000) N   

 
LIST_ID 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – AU_CAUSES 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – AU_CAUSES 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK, FK FK – AU_CAUSES 
ID303D Unique identified for 303(d) listing ID VARCHAR2(50) Y PK  
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OBSERVED_EFFECTS 
Field Name Description Type Not 

Null 
Constraint Comment 

ID305B Unique identifier for assessment unit 
(water segment) ID state defined 

VARCHAR2(50) Y PK, FK FK – 
WQS_ATTAINMENTS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – 
WQS_ATTAINMENTS 

USE_ID EPA unique identifier assigned to a 
designated use 

NUMBER(6) Y PK, FK FK – 
WQS_ATTAINMENTS 

CAUSE_ID EPA unique identifier assigned to the 
cause 

NUMBER(6) Y PK, FK FK – CAUSE_LUT 

OBSERVED_EFFECTS_COMMENT Comment on the observed effect VARCHAR2(4000) N   
 
PROJECT_CAUSES 
Field Name Description Type Not Null Constraint Comment 
PROJECT_ID Unique identifier for probability survey. ID state 

defined 
VARCHAR2(50) Y PK, FK FK – PROJECT_INFO 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – PROJECT_INFO 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK, FK  FK – CAUSE_LUT 
P_CAUSE_EST Percent of non-attaining population impaired by 

the specific cause 
NUMBER(28,5) N   

 
PROJECT_DOCUMENTS 
Field Name Description Type Not Null Constraint Comment 
PROJECT_ID Unique identifier for probability survey. ID state 

defined 
VARCHAR2(50) Y PK, FK FK – PROJECT_INFO 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – PROJECT_INFO 
DOC_ID Identifier for the stored file NUMBER(6) Y PK, FK FK – PS_DOCUMENTS 
STATE State or other jurisdiction CHAR(2) Y PK, FK FK – PS_DOCUMENTS 
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PROJECT_GIS 
Field Name Description Type Not Null Constraint Comment 
PROJECT_ID Unique identifier for probability survey. ID state 

defined 
VARCHAR2(50) Y PK, FK FK – PROJECT_INFO 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – PROJECT_INFO 
GIS_ID Unique State assigned identifier use to identify the 

GIS zip file 
VARCHAR2(50) Y PK  

GIS_DATUM Datum of the GIS file e.g., NAD83 VARCHAR2(30) N   
GIS_SCALE Scale of the GIS file e.g., 1:100K VARCHAR2(30) N   
GIS_PROJECTION Projection of the GIS file  VARCHAR2(30) N   
GIS_DESC Description of the contents of the GIS files e.g., 

target population 
VARCHAR2(255) N   

GIS_FILE The stored zipped GIS files BLOB N   
 
PROJECT_INFO 
Field Name Description Type Not Null Constraint Comment 
PROJECT_ID Unique identifier for probability 

survey. ID state defined 
VARCHAR2(50) Y PK  

CYCLE Calendar year of the assessment CHAR(4) Y PK  
STATE State or other jurisdiction CHAR(2) Y   
PROJECT_NAME Name of the project VARCHAR2(255 Y   
TARGET_POPULATION Description of the project target 

population 
VARCHAR2(255) Y   

NUM_SITES Number of sites included in the project NUMBER(6) N   
WATER_TYPE EPA Watertype represented by the 

target population 
VARCHAR2(30) Y   

TOTAL_WATER_SIZE Total size represented by the target 
population 

NUMBER(28,6) Y   

ASSESSED_WATER_SIZE Total size of the waters assessed NUMBER(28,6) N   
LOCATION_TYPE Description of the type of location (i.e., 

8-digit HUC, County, Statewide, etc. 
VARCHAR2(50) N   

LOCATION_DESC Values or description of the locations 
associated with a project 

VARCHAR2(4000) N   

INDICTATOR_NAME Indicator that was monitored (e.g. 
Biological, Trophic State Index, etc.) 

VARCHAR2(50) Y   

INDICATOR_DESC Description of the indicator monitored VARCHAR2(4000) N   
ANALYSIS_DATE Date the attainment decision was made DATE N   
PERCENT_ATTAINING Percent of target population attaining 

standards 
NUMBER(28,6) Y   
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PERCENT_NOT_ATTAINING Percent of target population not 
attaining standards 

NUMBER(28,6) Y   

PERCENT_NON_RESPONSIVE Percent of target population for which a 
use attainment assessment could not be 
completed 

NUMBER(28,6) Y   

N_CONF_INTERVAL Precision of the not attaining estimate 
in the form of 90%, 95% or 99% 
confidence intervals 

NUMBER(28,6) N  Values in (90, 95, 99) 

N_STANDARD_DEV Standard deviation for the not attaining 
decision 

NUMBER(28,6) N   

N_LOWER_CL The lower confidence interval for the 
not attaining decision 

NUMBER(28,6) N   

N_UPPER_CL The upper confidence interval for the 
not attaining decision 

NUMBER(28,6) N   

A_CONF_INTERVAL Precision of the attaining estimate in 
the form of 90%, 95% or 99% 
confidence intervals 

NUMBER(28,6) N  Values in (90, 95, 99) 

A_STANDARD_DEV Standard deviation for the attaining 
decision 
 

NUMBER(28,6) N   

A_LOWER_CL Standard deviation for the attaining 
decision 

NUMBER(28,6) N   

A_UPPER_CL The lower confidence interval for the 
attaining decision 

NUMBER(28,6) N   

I_CONF_INTERVAL Precision of the non responsive 
estimate in the form of 90%, 95% or 
99% confidence intervals 

NUMBER(28,6) N  Values in (90, 95, 99) 

I_STANDARD_DEV Standard deviation for the non 
responsive decision 
 

NUMBER(28,6) N   

I_LOWER_CL Standard deviation for the non 
responsive decision 

NUMBER(28,6) N   

I_UPPER_CL The lower confidence interval for the 
non responsive decision 

NUMBER(28,6) N   

ASSMNT_METHODOLOGY Flag used to track whether an 
assessment methodology document 
was used to make the attainment 
decisions 

CHAR(1) N  Values in (‘Y’, ‘N’) 

MONITORING_STRATEGY Flag used to track whether a CHAR(1) N  Values in (‘Y’, ‘N’) 
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monitoring strategy document is 
associated with the project 

USES_OPTION Code used to track whether the project 
is associated with state or national uses 

CHAR(1) N   

 
PROJECT_SOURCES 
Field Name Description Type Not Null Constraint Comment 
PROJECT_ID Unique identifier for probability survey. ID state 

defined 
VARCHAR2(50) Y PK, FK FK – PROJECT_INFO 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – PROJECT_INFO 
SOURCE_ID EPA unique identifier assigned to the source of 

the pollutant 
NUMBER(6) Y PK, FK FK – SOURCE_LUT 

P_SOURCE_EST Percent of non attaining population attributable to 
a particular source of pollution 

NUMBER(28,6) N   

 
PROJECT_USES 
Field Name Description Type Not Null Constraint Comment 
PROJECT_ID Unique identifier for probability survey. ID state 

defined 
VARCHAR2(50) Y PK, FK FK – PROJECT_INFO 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – PROJECT_INFO 
USE_ID EPA unique identifier assigned to a designated 

use 
NUMBER(6) Y PK, FK FK – USE_LUT 

 
PS_DOCUMENTS 
Field Name Description Type Not Null Constraint Comment 
DOC_ID Identifier for the stored file NUMBER(6) Y PK  
STATE State or other jurisdiction CHAR(2) Y PK  
DOC_DESC Description of the stored document VARCHAR2(255) Y   
PS_DOCUMENT Stored file BLOB N   
 
SOURCE_GROUPS 
Field Name Description Type Not Null Constraint Comment 
SOURCE_ID EPA identifier indicating the source of the 

pollutant 
NUMBER(6) Y PK, FK FK- SOURCES_LUT 

SRC_GROUP_ID Code designating a group of sources NUMBER(6) Y PK, FK FK – 
SOURCE_GROUPS_LUT 
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SOURCES 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK - CAUSES 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – CAUSES 
USE_ID EPA unique identifier assigned to a designated 

use 
NUMBER(6) Y PK, FK FK – CAUSES 

CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK, FK FK – CAUSES 
SOURCE_ID EPA identifier indicating the source of the 

pollutant 
NUMBER(6) Y PK, FK FK – SOURCE_LUT 

SOURCE_COMMENTS Additional free-text information concerning the 
source 

VARCHAR2(4000) N   

CONFIRMED Flag used to identify whether the source has 
been confirmed (‘Y’, ‘N’) 

CHAR(1) N  Values in (‘Y’, ‘N’) 

 
STATE_ASSESSMENTS 
Field Name Description Type Not 

Null 
Constraint Comment 

STATE State or other jurisdiction CHAR(2) Y PK, FK FK – STATES 
CYCLE Calendar year of the assessment CHAR(4) Y PK  
MERCURY_ COMMENT Comment on the 5M mercury reduction strategy VARCHAR2(4000) N   
MERCURY _URL Field stores the URL to a website or document detailing 

the 5M mercury reduction strategy 
VARCHAR2(250) N   

 
TMDLS 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK – AU_CAUSES 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK – AU_CAUSES 
CAUSE_ID EPA unique code identifying cause code TMDL 

applies to 
NUMBER(6) Y PK, FK FK – AU_CAUSES 

TMDL_ID The EPA total maximum daily load (TMDL) 
document ID that was developed for this 
assessment unit 

NUMBER(6) Y PK  
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USER_CATEGORIES 
Field Name Description Type Not Null Constraint Comment 
STATE State or other jurisdiction CHAR(2) Y PK  
CATEGORY_ID State defined identifier for a category VARCHAR2(10) Y PK  
CATEGORY_DESC Description of state defined category VARCHAR2(4000) N   
 
WQS_ATTAINMENTS 
Field Name Description Type Not Null Constraint Comment 
ID305B Unique identifier for assessment unit (water 

segment) ID state defined 
VARCHAR2(50) Y PK, FK FK –ASSESSMENT_UNITS 

CYCLE Calendar year of the assessment CHAR(4) Y PK, FK FK –ASSESSMENT_UNITS 
USE_ID EPA unique identifier assigned to a 

designated use 
NUMBER(6) Y PK, FK FK – USE_LUT 

ATTAINMENT The attainment status for a particular 
assessment unit's designated use 

CHAR(1) Y FK FK – ATTAINMENT_LUT 

THREATENED_FLAG Flag used to indicate threatened waters. 
Threatened waters are those assessment units 
where designates uses are being attained, but 
non-attainment is predicated by the time the 
next Integrated Report is due to be submitted 

CHAR(1) N  Values in (‘Y’, NULL) 

USER_FLAG State definable field for uses VARCHAR2(15) N   
USE_COMMENT Additional free-text information concerning 

the use 
VARCHAR2(4000) N   

ASSMNT_DATE Date on which the use was assessed DATE N   
START_DATE Date on which the use assessment was started DATE N   
END_DATE Date on which the use assessment ended DATE N   
SAMPLE_DATE Date on which a sample was taken DATE N   
KEY_DATE Date use to mark a key date associated with 

the use 
DATE N   

ASSESSOR Individual performing assessment VARCHAR2(40) N   

EPA_ADDED Flag indicates whether EPA added a water or 
cause of impairment to the 303(d) list 

CHAR(1) N   

STATE_USE_CATEGORY The integrated report category for the 
assessment unit-use combination reported by 
the state 

VARCHAR2(10) N   
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LOOKUP TABLES 
 
ASSESSMENT_CONF_LUT 
Field Name Description Type Not Null Constraint 
ASSMNT_CONF A score ranging from a lower range of 1 to an upper range of up to 4 

indicating the reliability and precision of the applied assessment for a 
category of use-specific assessment type 

CHAR(2) 
 

Y PK 

ASSMNT_CONF_DESC The textual description of the reliability and precision of the applied 
assessment for a category of use-specific assessment type 

VARCHAR2(200) 
 

Y  

 
ASSESSMENT_TYPE_LUT  
Field Name Description Type Not Null Constraint 
ASSMNT_TYPE Code designating a category of data types used to make 

attainment/impairment decision 
NUMBER(6) Y PK 

ASSMNT_TYPE_DESC Description of the assessment type VARCHAR2(4000) Y  
 
ATLAS_LUT  
Field Name Description Type Not Null Constraint 
TOPIC_ID Code for the water type (i.e., River) or population NUMBER(6) Y PK 
TOPIC_OWNER Denotes whether the topic is one of the default options or one added 

by the state 
CHAR(2) Y PK 

TOPIC Description of the water type or population VARCHAR2(50) N  
TOPIC_GROUP Denotes higher level group the topic belongs to (i.e., rivers would 

belong to the TOTAL STREAMS/CREEKS/RIVERS topic group 
VARCHAR2(50) N  

SIZE_UNIT Size of the topic VARCHAR2(15) N  
MAJOR_FLAG Denotes whether the topic is one of the major topic groups NUMBER(6) N  
 
ATTAINMENT_LUT  
Field Name Description Type Not Null Constraint 
ATTAINMENT Code for the attainment status for a particular assessment unit's 

designated use 
CHAR(1) Y PK 

ATTAINMENT_DESC Description of the attainment status for a particular assessment unit's 
designated use 

VARCHAR2(80) Y  

 
CAUSE_GROUP_LUT 
Field Name Description Type Not Null Constraint 
CAUSE_GROUP_ID Code designating a grouping of causes NUMBER(6) Y PK 
CAUSE_GROUP_NAME Cause group or classification name like "priority pollutant," "metals," 

or "carcinogens" 
VARCHAR2(240) Y  



ADBv2 User Guide 

 C-17 

 
CAUSE_LUT 
Field Name Description Type Not Null Constraint 
CAUSE_ID EPA unique identifier assigned to the cause NUMBER(6) Y PK 
CAUSE_NAME Name of the impairment cause VARCHAR2(240) Y  
CAS_NO Chemical abstract number for chemical impairment causes VARCHAR2(11) N  
EPA_NO EPA chemical identifier for biological impairment cause VARCHAR2(240) N  
BIN Biological identifier number for biological impairment cause VARCHAR2(10) N  
STORET_NO Storet system number VARCHAR2(10) N  
CAUSE_DESC Additional information concerning the impairment cause 

 
VARCHAR2(4000) N  

 
CLASS_LUT 
Field Name Description Type Not Null Constraint 
CLASS_ID Unique identifier for CLASS_ID assigned from WQSDB NUMBER(6) Y PK 
CLASS_NAME Name of the class from WQS Regs Document VARCHAR2(100) Y  
CLASS_DESC Description of Class from WQS Regs Document VARCHAR2(4000) N  
STATE ST - the 2 letter postal state abbreviations (e.g., VA for Virginia); 

exceptions are for 2 Interstate commissions. OV stands for 
ORSANCO (the Ohio River Valley Water Sanitation Commission) 
and DR stands for the Delaware River Basin Commission 

CHAR(2) 
 

N  

 
DELISTING_REASON_LUT 
Field Name Description Type Not Null Constraint 
DELISTING_REASON Code for the rationale for the delisting of an Assessment 

Unit/Pollutant combination 
NUMBER(6) Y PK 

DELISTING_REASON_D
ESC 

Description of the rationale for the delisting of an Assessment 
Unit/Pollutant Combination.   

VARCHAR2(255) Y  

REASON_FLAG A flag indicating whether this is a delisting reason (D) or WQS 
attainment (W) reason 

CHAR(1) N Values in 
('D','W') 

CURRENT_FORMAL_D
ESCRIPTION 

The current formal EPA delisting or WQS attainment description VARCHAR2(250) N  

SORT_ORDER Column used to sort the rows in a particular order NUMBER(6,0) N  
CURRENT_FLAG Column used to determine which delisting reasons are current NUMBER(6,0) N  
 
LOCATIONS_LUT 
Field Name Description Type Not Null Constraint 
LOCID Identifier assigned for the location NUMBER(6) Y PK 
STATE State or other jurisdiction CHAR(2) Y PK 
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LOCTYPE Type of location (e.g., HUC, County, Eco-region, etc) VARCHAR2(20) Y  
LOCATION Name of the location VARCHAR2(100) Y  
 
METHODS_LUT 
Field Name Description Type Not Null Constraint 
METHODCODE EPA unique identifier assigned to a method NUMBER(6) Y PK 
STATE State or other jurisdiction CHAR(2) Y PK 
METHODNAME Name of method VARCHAR2(90) Y  
 
SOURCE_GROUPS_LUT 
Field Name Description Type Not Null Constraint 
SRC_GROUP_ID Code designating a group of sources NUMBER(6) Y PK 
SRC_GROUP_NAME The name of the source group  Y  
 
SOURCE_LUT 
Field Name Description Type Not Null Constraint 
SOURCE_ID EPA identifier indicating the source of the pollutant NUMBER(6) Y PK 
SOURCE_NAME The source of a pollutant VARCHAR2(250) Y  
SOURCE_DESC Additional information about the pollutant source VARCHAR2(4000) N  
 
STATES 
Field Name Description Type Not Null Constraint 
REGION EPA Region ID VARCHAR2(2) Y  
STATE State or other jurisdiction CHAR(2) Y PK 
STATE_FIPS_CODE Federal Information Processing Standard Codes for the Identification 

of the States, The District of Columbia and the Outlying Areas of the 
United States, and Associated Areas 

VARCHAR2(2) Y  

STATE_NAME The name of the State VARCHAR2(20) Y  
 
TREND_LUT 
Field Name Description Type Not Null Constraint 
TREND Code for the water quality trend for a particular assessment unit as 

defined in Section 314 of the Clean Water Act 
CHAR(1) Y PK 

TREND_DESC Description of the water quality trend for a particular assessment unit 
as defined in Section 314 of the Clean Water Act 

VARCHAR2(50) Y  
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USE_LUT 
Field Name Description Type Not Null Constraint 
USE_ID EPA unique identifier assigned to a designated use NUMBER(6) Y PK 
USE_DESC Water use description as defined by EPA's Water Quality Standards 

System 
VARCHAR2(4000) Y  

STATE State or other jurisdiction CHAR(2) N  
EFFECTIVE_DATE The date that the state established the water use DATE N  
 
WATER_TYPE_LUT 
Field Name Description Type Not Null Constraint 
WATER_TYPE Water type of the assessment unit (e.g., River, Estuary, Wetland) VARCHAR2(30) Y PK 
EPA_WATER_TYPE An EPA defined water type (e.g., STREAM/CREEK/RIVER) VARCHAR2(30) Y  
SIZE_UNIT The standard unit of measure to use for this Watertype (miles, acres, 

square miles) 
VARCHAR2(15) Y  
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